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Welcome to

Many people who want to make the move from 

Windows to a Linux distribution choose Ubuntu as 

their first step. It provides a clean, attractive GUI with 

Unity, and usability by the bucket-load. It is the perfect 

environment in which to begin learning about the 

command line and creating a more customisable 

workspace. Meanwhile you still get many of the 

benefits you are used to in Windows and other 

desktop systems. This book serves as an introduction 

to the beauty and power of Ubuntu. From the default 

software to the best FOSS apps to download from 

the Software Centre, we’ll tour the top programs and 

applications, so soon you’ll be flying with Ubuntu.
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Get to know 
Ubuntu
This free, open-source operating system has gained 
a lot of momentum in recent years

Ubuntu is a user-friendly Linux-based operating system that has 

found its place in every corner of the world. Best of all, Ubuntu is 

absolutely free, including future updates. It is also extremely light 

on PC hardware, so you can install it on computers that are three 

to four years old and it’ll still run smoothly. So it’s for good reason 

that Ubuntu is the most widely used Linux operating system – 

for desktops and in the cloud. It boasts both community and 

professional support, and Ubuntu is suitable for both desktop and 

server use. But that’s not all:

Ubuntu is everywhere. Almost all computer manufacturers are 

shipping models based on Ubuntu.

Ubuntu is well supported. Few other Linux distros provide the 

same kind of long-term support. It is more important than ever to 

provide long-term support when it comes to open source projects.

Ubuntu is easy to use. It’s easy to pick up and use, even if you 

come from a Windows background (Fig 1). 

Ubuntu is pretty stable. For most users, Ubuntu just works. This is 

because the OS is being tweaked and i xed all the time. Since all the 

latest packages are not integrated during the development cycle, it 

also helps in providing better stability.

Fig 1 (right) The Ubuntu interface is easy 
to navigate and use
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Fig 2 (above) If successful, you will be presented with the standard Ubuntu desktop

As a newcomer to Ubuntu, 

you will be able to try it out 

before installing it. This can 

be done using either an 

Ubuntu DVD in the drive or a 

USB stick with Ubuntu on it 

in a USB port.

01 If using a DVD, put the 

Ubuntu DVD into the drive 

and restart the computer. 

You will see a welcome 

screen which prompts you to 

select your chosen language. 

There will also be an option 

to install Ubuntu or try it 

from the DVD.

02 If you want to use a 

USB drive, note that the 

latest computers can start 

up from a USB stick. Here 

you’ll also see a welcome 

screen that prompts you to 

choose a language and gives 

an option to either install 

Ubuntu or try it from the 

USB stick.

03 Irrespective of whether 

you are using the DVD 

or USB stick method, the 

next step is to select your 

preferred language and then 

click on ‘Try Ubuntu’. Your 

live desktop will then appear 

(as shown in the picture seen 

to the left, Fig 2).

04 As a final step, when you 

are ready to install Ubuntu, 

you just need to double-click 

on the icon on your desktop: 

’Install Ubuntu 16.04 LTS’.

Boot Ubuntu from a 
disc or USB stick

Start with the trial version
Try out Ubuntu before installing it

System requirements vary among Ubuntu products. For the Ubuntu 

desktop release 16.04, a PC with at least 512MB of RAM and 5GB of 

disk space is highly recommended. For less powerful computers, it’s 

best to use one of the other Ubuntu distributions. 

Ubuntu can be booted from a USB drive or CD and used without 

even installing it. Let’s take a look at the diferent ways to download 

and use the Ubuntu trial version…

Live booting and virtual machines
One of the easiest ways to get started with Ubuntu is by creating 

a live USB drive, CD or DVD. After placing Ubuntu onto it, you can 

insert your USB stick or disc into any computer, then restart it. The 

computer should then boot from the removable medium and you 

can use Ubuntu without making changes to the hard drive.

You may be wondering how to create a live Ubuntu USB drive or 

disc. For this, you can download the latest Ubuntu disk image from 

Ubuntu’s website. Use the UNetbootin tool to put Ubuntu on your 

USB lash drive or burn the downloaded ISO image to a disc. All you 

need to do now is to restart your computer from the removable 

medium you provided and select the ‘Try Ubuntu’ option. 
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Like any other operating system, Ubuntu can also be run in a 

virtual machine on your computer. In this way, you’ll be able to try 

Linux without even restarting your computer, although you should 

note that virtual machines are slower than running the operating 

system on your computer itself. 

To create an Ubuntu virtual machine, irst you need to 

download and install VirtualBox. Create a new virtual machine 

with it, select the Ubuntu operating system, and provide the ISO 

ile you downloaded from Ubuntu’s website when prompted. 

The installation process is pretty self-explanatory and you can go 

through it in the virtual machine as if you were installing Ubuntu on 

a real computer.

“You’ll be able to try Linux without even 
restarting your computer”

Fig 3 (below) Install Ubuntu or try it 
out with the trial version
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Adopting the full version
New versions are released every six months 

and are supported for 18 months

As noted previously, Ubuntu is a very popular Linux distribution with 

many years of experience and a huge user base. After becoming 

comfortable with the initial aspects of Ubuntu, it is time to take 

a look at Ubuntu’s full version. Before you start with Ubuntu, you 

need to obtain a copy of the Ubuntu installation image. In addition, 

you will have to ensure that your system meets the minimum 

requirements. The most common method of obtaining Ubuntu is 

to download the Ubuntu DVD image directly from the oicial site, 

ubuntu.com/download. To download and install it, you just need 

to select whether you require the 32-bit or 64-bit version and then 

click ‘Start download’.

It is important to understand these two versions that Ubuntu 

is available in: 32-bit and 64-bit. They difer from each other in the 

way the computer processes information. So if your computer has 

a 64-bit processor, you will need to install the 64-bit version. On 

the other hand, if you have an older computer or you do not know 

the type of the processor in your computer, it is advisable to opt to 

install the 32-bit version. 

Although 5GB of free space on your hard drive is required for 

installing Ubuntu, the recommendation is to have 15GB or more. 

This will mean you’ll have enough space to install extra applications, 

as well as to store your own documents, music and more. 

If you have an Internet connection, the installer will ask you now 

whether you want to ‘Download updates while installing’. It is highly 

recommended to perform this step.

It is important to have an 

Internet connection during 

the Ubuntu installation 

process. If you are not 

connected to the Internet, 

the installer will ask you to 

choose a wireless network, 

if one is available. You can 

follow these three steps in 

such a scenario…

01  Select ‘Connect to this 

network’ and choose your 

network from the list.

02  In the ‘Password’ field, 

enter your router’s WEP or 

WPA key.

03  Then click ‘Connect’ in 

order to continue.

Internet connection

Fig 4 (below) Make sure you have the 
available drive space before installing
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The Ubuntu installer will automatically detect any existing operating 

system installed on your machine, and present installation options 

to suit your system. Please note that the following options below 

entirely depend on your speciic system and may not all be 

available to you:

Out of the above four options, the most preferred is ‘Upgrade 

Ubuntu … to 16.04’. This is because this option will allow you to 

keep all your precious documents, music, pictures and any other 

personal iles on the computer. Installed software will be retained 

when possible and system-wide settings will be cleared.

The ‘Erase disk and install Ubuntu’ option can be used if you want 

to erase your entire disk. As expected, this will delete any existing 

operating system that is installed on that disk and install Ubuntu in 

its place.

When you choose the ‘Something else’ option, you will be able 

to conigure the partitions as you need before installing Ubuntu.

It can be noted here that in order to reduce the time required 

for installation, Ubuntu will continue the installation process in the 

background while the user conigures all the important user details 

like username, password, keyboard settings, the default time zone 

and so on.

You can install Ubuntu alongside another OS or replace it

“After successfully installing Ubuntu, 
you may also want to encrypt your 
home folder. It takes very little time 
and is pretty straightforward. This is 
considered to be an important step 
before you proceed any further”
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After taking a look at the initial aspects of Ubuntu, now it’s time 

to delve deeper into the operating system. To start with, you may 

notice many similarities between Ubuntu and other operating 

systems – mainly because they are all based on the concept of 

a GUI (graphical user interface). It is a good idea to understand 

the applications and menus in Ubuntu so that you can become 

comfortable with using its GUI. Any GUI-based operating system 

makes use of a desktop environment. The main features provided 

by a desktop environment are related to the look and feel of the 

system and how easily a user can navigate the desktop.

Let us take a quick look at the menu bar in Ubuntu. The menu 

bar incorporates the most common functions used in Ubuntu. 

Each installation of Ubuntu may contain slightly diferent icons 

based on a number of factors, including the type of hardware. 

Fig 5 You can choose to 
employ the Terminal

You may notice that Ubuntu 

is a little different to some 

other operating systems. 

The most important thing 

to understand is the Ubuntu 

packaging system. Typically 

it includes:

/usr

/var

/bin

/sbin

/lib

The other thing to note here 

is cron job management. 

The jobs that are the under 

the purview of the system 

administrator can be found 

in the /etc directory. If you 

have a root cron job for 

daily, weekly or monthly 

runs, make sure to place 

them under /etc/cron.

{daily,weekly,monthly}. 

These jobs can be invoked 

from /etc/crontab.

There is a tool called ‘Ubuntu 

After Install’, which can be 

used to install some of the 

best and most essential 

software after installing the 

Ubuntu desktop. It boasts a 

bunch of useful applications, 

and will automate the 

installation process on a 

newly installed machine 

in order to obtain a near 

perfect desktop. This tool 

will save a lot of your time 

and effort, and installs all 

latest versions of software on 

your Ubuntu system.

Navigate Ubuntu
Decode the menu bar, Launcher, Dash, home 

directory and more
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For example, some programs add an icon to the indicator area 

automatically during installation. You should note that every 

application features its own menu system wherein diferent 

actions can be executed within it (such as File, Edit, View and so 

on). Appropriately, the menu system for an application is known 

as the application menu.

Another thing that we need to understand in Ubuntu is the 

‘Launcher’ – the vertical bar of icons available on the left side of 

the desktop (Fig 6). With the help of this Launcher, one can easily 

access the various applications, mounted devices and trash. Note 

that any application that is running will have its icon placed in 

the Launcher bar. 

In Ubuntu, we commonly come across something called 

‘Dash’. If you have used Windows in the past, you can consider 

Dash as something similar to the Windows Start menu. The Dash 

will help you to ind the applications and iles you’re looking 

for on your machine. To explore the Dash, you need to click on 

the topmost icon on the Launcher. Now you will be able to see 

a window with a search bar on the top as well as the recently 

accessed applications, iles and downloads.
Fig 6 (above) To run any application from the Launcher, 
you just need to click on the application’s icon

Fig 7 Type to search for files or folders and suggested 
results will appear in the Dash menu
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Fig 8 (above) Conduct a computer and Internet-wide search from the Dash

Fig 9 (above) Navigate to the browser app for more advanced searches
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As mentioned above, Dash is a very powerful tool that can be 

used to search for iles and applications on your computer. Find iles 

or folders by simply typing a portion of the ile or folder name (Fig 7, 

page 14). As you type, the results will appear in the Dash.

As expected, a standard Ubuntu installation comes with many 

applications, but users can additionally download thousands of 

applications from the Ubuntu Software Centre. The Applications 

lens on the Dash will automatically categorise installed applications 

under ‘Recently Used’, ‘Installed’ or ‘More Suggestions’. 

You can also enter the name of an application (or a part of it) 

into the search bar in the Dash, and the names of applications 

matching your search criteria will appear (Fig 8, page 15). Even if you 

don’t remember the name of the application, type a keyword that 

is relevant to that application and the Dash will be able to ind it. 

Another thing that we need to understand here is that in addition 

to searching your local machine for iles and applications, Dash can 

help in searching various online resources.

Now let’s take a look at how to browse the iles on your machine. 

In addition to using Dash to search for iles, one can also access 

them directly from their directory. The home directory (Fig 10) is 
Fig 10 (below) Search the home directory for 
files on your machine
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used to store all of your personal iles (instead of system-related iles). 

Sometimes, you may need to make use of the ‘Files’ ile manager 

window. Whenever you select the Files shortcut in the Launcher, 

Ubuntu will open this ile manager. 

As you can see from the screenshot opposite, this window comes 

with the following features:

menu bar:  It is located at the top of the screen. With this 

menu bar, one will be able to browse and remove 

bookmarks, open a new window, connect to a server, 

quit etc.

title bar:  This indicates the name of the currently 

selected directory. 

toolbar:  This displays your location in the ile system, a search 

button etc.
Fig 11 (below) Most customisation options are 

available in the System Settings menu
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Ubuntu uses the Linux file 

system and it is based on a 

series of folders in the root 

directory. These folders 

contain important system 

files that cannot be modified 

unless you are running as 

the root user or use the 

sudo command. With this 

restriction, computer viruses 

will not be able to change 

the core system files, and 

normal users will not be 

able to accidently change 

anything that is critical.

Ubuntu file system 
structure

Sometimes, you may need to customise your Ubuntu desktop. 

Most customisation can be achieved via the Session Indicator 

and then selecting System Settings to open the System Settings 

application window (Fig 11, page 17).

Once you are done with working on your machine, you can 

select from the options to log out, suspend, restart or shut down 

through the Session Indicator.

“Although Ubuntu provides a nice GUI, 
to fully utilise the power of the OS you’ll 
need to understand the ‘terminal’”

Understand the terminal
Go further by utilising the command line

Although Ubuntu provides a nice GUI, to fully utilise the power 

of the OS you’ll need to understand the ‘terminal’. Any operating 

system has two types of user interface:

GUI: This is the desktop, windows, menus and toolbars that you 

click to get things done.

Command-line interface (CLI): The terminal is Ubuntu’s CLI. It 

can be considered as a method for controlling some aspects of 

Ubuntu using only commands that you type on the keyboard. Even 

though users are able to perform most day-to-day activities without 

ever opening a terminal, it is considered to be very powerful tool 

and is therefore well worth investigating. With it, you will be able to 

perform many useful tasks. 

Troubleshooting tasks: If you face any diiculties while using 

Ubuntu, you may need to use the terminal. If you need to perform 

operations on multiple iles at the same time, then the terminal 

is the preferred method. System administration and software 

development skills can be signiicantly improved by having a good 

understanding of the CLI. A terminal can be opened either by 

hitting Alt+Ctrl+T or by right-clicking on the desktop and selecting 

‘Terminal’ from the menu.

Please note that all the commands in the terminal follow the 

same approach: you can type the command, possibly followed 



Getting startedGet to know Ubuntu

19

Ubuntu is considered to be 

so secure primarily thanks to 

the following reasons…

primarily target Windows-

based systems do not affect 

Ubuntu systems.

source software like Ubuntu 

are often released quickly.

Ubuntu allows security flaws 

to be easily detected.

concepts such as file 

permissions, passwords 

and user accounts are also 

Understanding these 

concepts will help you in 

securing your computer.

File A quick description

/etc/issue
running

/etc/apt/sources.list

lsb_release -a

/usr/share/tomcat

by some parameters, and then press Enter in order to perform the 

speciied action (Fig 12). In most cases, some type of output will 

be displayed in order to conirm that the action was completed 

successfully, although this can depend on whether the command 

is executed.

Ubuntu ofers various text editors which are installed by default. 

The most commonly used command-line editor is called Vim. The 

table below gives quick information about some of the important 

iles in Ubuntu.

Another concept that users need to know about is mounting 

and unmounting removable devices. Mounting a device means 

associating a directory name with the device, and this in turn 

allows you to navigate to the directory to access the device’s iles. 

When you’ve inished using a device, you can safely unmount it. 

Unmounting a device disassociates the device from its directory, 

allowing you to eject it.

Fig 12 (above) Use the terminal to conduct actions using the command line
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Navigate the 
Ubuntu desktop
Find everything you need on the intuitive and attractive 
Ubuntu desktop interface, Unity

When Ubuntu irst introduced its Unity desktop, 

some users threatened to move back to 

Windows Vista. But as time went by, the desktop 

became more reliable: as of 12.04 LTS, there 

is no real reason to dislike Unity. Unity initially 

started out as a research product trying to create 

a GUI that was better suited to netbooks: their 

extremely wide displays did not work particularly 

well with traditional desktop managers that 

had been intended for workstations utilising 

the standard 4:3 displays. This explains two 

important changes to the interface: irst of all, 

the Launcher was moved to the side of the 

screen to preserve the valuable vertical real 

estate. Secondly, the menu bars of the various 

diferent applications were grouped together 

into one top bar that is always dedicated to the 

currently enabled application. This is one of the 

main diferences you will ind from Windows and 

other distros in terms of usability, but it is one 

that you will become accustomed to over time. 

While getting up to speed with Unity might 

take users a bit of time, rest assured that you will 

eventually see are more than worth it.

“Unity initially started out as a research product trying to create 
a GUI that was better suited to netbooks”

Trash 
Just where you’d expect to find it, 
the trash can is always visible at the 
bottom of the quick launch bar

View app status
All of the running applications are 
shown below the Dash symbol. 
The arrows located on the left 
side of the icon let you know 
the number of windows that are 
currently open. On dual-screen 
workstations, an ‘empty’ arrow 
here indicates that the window 
is not located on the display that 
is showing this particular version 
of the bar

Quick-launch apps
Right-click on the symbol of a 
running application to open a 
short menu. Selecting ‘Lock to 
Launcher’ from the available 
options ensures that the symbol 
will always remain in the bar 
for quick access to that specific 
application, even if it is not 
currently running
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The Dash
Unity’s start menu is keyboard-driven 
and opening it in this way can save time. 
Savvy users will open it using the Windows 
key on their keyboard. You can get a real 
productivity boost by following it up with a 
few characters describing the app you are 
looking for, for example by entering ‘Thun’ 
after tapping the Windows key virtually 
ensures that the Thunderbird icon appears 
right in the middle of the application list

The menu bar
Move your mouse cursor 
up to the very top of the 
screen to enable the menu 
display. This is a really 
helpful tool for accessibility 
as less dexterity is required 
to complete it. Simply flick 
the cursor to the top of the 
screen and let Unity take 
care of any overshoot

Wallpaper
As with practically any 
other distro or OS, your 
wallpaper is a blank 
canvas to put your own 
stamp on. The default 
Ubuntu offering isn’t too 
shabby, though

The indicator menu
Ubuntu will display symbols 
alerting you about any events 
and/or important system 
state changes that are taking 
place or need your attention. 
Click on any of these icons 
when they appear to reveal 
a short menu providing you 
with further options about the 
situation at hand

The keyboard 
cheatsheet
Unity comes with a set of helpful 
keyboard shortcuts that increase 
productivity and get things done 
faster. Press and hold on the 
Windows key to display a list of 
shortcuts in the middle of the screen 
that is currently active

Active  workspace 
Front and centre is the window you’re 
working on. To switch to another without 
closing the current window, just click on 
or search for the app you want to open 
next. It can be minimised if you hover at 
the top of the window – the classic three 
buttons will appear with options to close, 
minimise or maximise. Be aware that 
clicking the close option will mean you 
need to start the program again
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Dual boot
with Ubuntu
Get Ubuntu running alongside your existing 
Windows installation

Most users who want to try Ubuntu already have desktop PCs or 

laptops with the Windows OS. Ubuntu can be installed alongside 

Windows and both systems will coexist just i ne, without interfering 

with each other.

Ubuntu’s installation wizard has an advanced disk partition stage, 

where you can either trust the installer to automatically shrink the 

Windows partition and let Ubuntu use the freed space, or you can 

do it manually. Shrinking NTFS partitions from Linux is considered 

stable enough and if you didn’t have any problems with your C 

drive in Windows (such as severe fragmentation), Ubuntu will resize 

it correctly. The installer will create the mandatory root partition (/) 

in the free disk area and sometimes also create separate partitions 

for user data (/home) and swap space. 

After the installer copies Ubuntu i les to the root partition, it’ll 

perform post-installation arrangements and install the GRUB2 

bootloader into the master boot record (MBR) of the hard drive 

on older systems, or GRUB2-EFI into the dedicated FAT32 partition 

on modern systems with Windows 8 or 10 and a GPT-formatted 

drive. The Ubuntu installer supports the Secure Boot feature of 

many modern Windows PCs and installs the GRUB2-EFI bootloader 

correctly. After rebooting, you’ll see the GRUB2/GRUB2-EFI interface, 

where you can choose Ubuntu or Windows. 

You will i nd that it’s possible for you to access Windows i les from 

Ubuntu, but not vice versa.

“Ubuntu can be installed alongside Windows and both 
systems will coexist just i ne”
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Discover bootloader menu  Find out how to use the GRUB2 bootloader

Boot Windows
Select the last entry to boot Windows. GRUB 
will redirect you to the Microsoft standard 
bootloader that sits on the Windows partition

Reveal the power of GRUB
You can instantly change boot settings by 
pressing the E key, editing an entry and then 
pressing F10. This is a one-time solution: GRUB 
will discard such custom settings after reboot

Meet the GNU GRUB
GRUB in Ubuntu looks nearly 
identical on systems with a BIOS 
or UEFI setup. The version of the 
program is displayed on the top

The default entry
If you do nothing, GRUB will load the default 
menu entry, which is the first one in the list. 
It always points to the latest installed kernel 
version with default parameters

“You will ind that it’s possible for you to access Windows iles 
from Ubuntu, but not vice versa”
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Dare to go for manual setup 
Ubuntu’s installation program has been polished in recent years 

and now looks very smooth. Soon after completing basic steps 

(like language selection), a user faces the irst real obstacle during 

the ‘Installation type’ step. You can see above that Ubuntu has 

automatically detected our Windows 7 copy and ofered the simple 

solution that does not require any extra user input (Fig 1). Here you 

can let the installer automatically guess what OS you already have 

and how to keep it intact. It’s safe, and you’ll be able to deine how 

much space you want to allocate for Ubuntu in the next step.

Note the second option with the red Warning label – we are 

going to install Ubuntu and keep Windows working, so do not 

choose this. The last option is a path to a more expert-like drive 

allocation program. Dual-booting in UEFI mode introduces more 

routines for the Ubuntu installer. If you’re unsure what to choose, 

go with auto mode. If your system uses a BIOS interface, you can 

repartition your drive manually.

The automatic partitioning 

option in the Ubuntu 

installer is definitely more 

comfortable for non-tech-

savvy users, but it does have 

certain limitations, such as 

the inability to add an extra 

Home partition or define 

the swap space manually. 

Let’s use the fully fledged 

partitioning method by 

choosing the ‘Something 

else’ option in the previous 

step, or by clicking the 

‘Advanced partitioning tool’ 

link in the ‘simple’ mode. 

First, you’ll need to resize 

the NTFS volume and make 

it smaller by some number 

of gigabytes. Make sure that 

you don’t have excessive 

hard disk fragmentation 

in Windows, otherwise 

you may turn your NTFS 

volume in Ubuntu installer 

unusable. Try to guess how 

much space you’ll need in 

the unallocated area after 

shrinking. For instance, 

10GB looks like the bare 

minimum – go with at least 

twice as much as that for the 

Ubuntu root partition. Think 

ahead to cover aspects like 

swapping and a separate 

partition for /home.

Discover 
bootloader menu     

“The automatic partitioning option in 
the Ubuntu installer is deinitely more 
comfortable for non-tech-savvy users, 
but it does have certain limitations”

Fig 1 (above) The installation type has 
been automatically detected
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Select target drive for the bootloader
This option only requires your attention if it’s the case that you have 

more than one hard drive inside or attached to your computer. 

Otherwise, if you had previously installed custom operating systems 

onto your Windows desktop PC or laptop, you might ind it useful 

to get to grips with this option as well. First of all, in order to boot 

correctly, Ubuntu needs a properly installed GRUB bootloader. 

You can install it on a hard drive (eg /dev/sda) or on a drive 

partition (eg /dev/sda3). If you have a relatively modern UEFI/Secure 

Boot setup, then Ubuntu will act diferently: it will install GRUB2-EFI 

on /dev/sda1, which is a FAT32 partition, and mount it as /boot/ei. 

Furthermore, a special loader entry in your computer’s UEFI internals 

will be made by the means of the ‘eibbotmgr’ utility. Don’t worry 

though, Ubuntu does all of this automatically.

Many older articles 

concerning the installation of 

Linux strongly advise users 

to create a swap partition 

with a size twice that of the 

RAM volume (for instance, 

2GB if you have 1GB of 

RAM). However, modern 

computers generally have 

larger amounts of RAM and 

therefore this rule is not that 

important any more. That 

being said, you could go 

without the swap partition 

altogether unless you feel 

that you really need it. The 

separate partition for your 

home folder in Ubuntu is 

another aspect to consider. 

If you go with a single root 

partition, that means all your 

personal files and settings 

will be kept together with 

the rest of the system on a 

single partition (/), just like 

if you only had the C: drive 

in Windows for storing 

everything. Sometimes it 

is more sensible to create 

another partition and mount 

it as /home – this means 

that your files and settings 

will not get lost, even if you 

decide to reinstall or remove 

Ubuntu in the future.

Create Ubuntu 
partitions     

“If you go with a single root partition, that 
means all your personal iles and settings 
will be kept together”

Fig 2 (above) Install GRUB bootloader onto a hard 
drive or drive partition
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Customising 
the desktop
Change desktop settings and add a personal touch 
to Ubuntu’s exterior

The default desktop environment in Ubuntu is called Unity. It 

provides users with a consistent and easy-to-use graphical interface 

for performing everyday tasks. The default settings are quite simple, 

based on studies into the features people i nd comfortable and 

intuitive. However, with so many people with so many dif erent 

tastes, Unity allows all essential features, such as appearance and 

behaviour of the desktop, to be customised to the user’s liking.

This is done with the Look and Feel settings, localisation, input 

options as well as privacy-related settings. Some of the above 

don’t af ect Ubuntu behaviour – such as various aesthetic settings 

(theme, icons), but some do.

It is worth mentioning that sometimes people need more 

precise control over their Ubuntu installation and require some 

extra features that are not part of the out-of-the-box Ubuntu. For 

that reason, there are dif erent ways to work around it in the form 

of commands ($ gsettings) and even stand-alone tweakers (eg 

Unity-tweak-tool). Such extras let you change advanced settings 

like fonts, window control placement, desktop ef ects and more. 

Next you can i nd out how you can change the most common 

settings and resolve frequently occurring issues.

01 
The taskbar panel or the Launcher works just fine, but sometimes you 

need to get rid of some of the default icons and add your favourite apps 

instead. To remove an icon, right-click on it and select the ‘Unlock from Launcher’ 

option. To add an application to the taskbar you first need to find it in the Dash 

and drag it to the desired position on the taskbar. You can also drag and rearrange 

the existing icons on the taskbar. Use the Appearance>Look section in System 

Settings to change the taskbar icon size. If you make it smaller, more icons will fit 

there, which is helpful for small displays. Also, check the Behaviour tab for auto-

hiding option, enabling multiple workspaces and more.

Adjust the Launcher

Ubuntu essentials
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Unity Tweak Tool
It’s not included right out of the 
box, but it is instantly available in 
the standard Ubuntu online repos-
itory. Get it with $ sudo apt-get 
install unity-tweak-tool

Appearance settings
Here you can change GTK style, 
window decoration theme 
and fonts separately, change 
mouse cursor look and move 
window buttons to another 
edge of a window

Change specific 
settings
Unity is made up of various 
different elements, including 
the main taskbar which is along 
the right side of the screen, 
the main menu with a search 
feature (Dash), the top panel 
and the task switcher

System settings
Unity Tweak Tool offers 
advanced system settings, eg 
enabling desktop icons, extra 
security measures, control 
over scroll bars as well as 
mouse behaviour

Window manager
There are ways to can change 
the behaviour of window 
manager in Unity. Shadows, 
translucency, animations, hot 
corners, snapping, focusing 
rules, etc

A Register Editor  
for Ubuntu
Use the command $ sudo 
apt-get install dconf-

editor to install a twin panel 
settings manager. It behaves 
similarly to the Register Editor 
in Windows OS and lets you 
adjust many hidden settings

Default wallpaper
You can set the default Ubuntu 
wallpaper to a photo (or maybe 
a drawing) of your choice in 
the Appearance section of the 
standard System Settings

Change the theme
This defines how various 
UI controls look, and this 
includes buttons, scroll bars, 
menu background, window 
decorations and lots of 
other details

“With so many people with so many diferent tastes, Unity 
allows all essential features, such as appearance and behaviour 
of the desktop, to be customised”

Ubuntu essentials

Tweak desktop settings  Use related sections in Ubuntu’s System Settings app



Fig 1 (above) You can use hot corners 
to streamline your Ubuntu experience

03 
Changing the interface theme 

can dramatically alter the 

working experience. It is perfectly 

safe: you don’t change how your 

desktop works, you change how it 

looks. By default, Ubuntu ships with 

three themes: Ambiance (the default 

one), Radiance (light colours) and 

High Contrast (for visually challenged). 

You can add more by installing new 

themes via command line (adding 

a PPA with a theme and installing its 

package for example), or download 

themes manually from sites like 

gnome-look.org. Ubuntu looks for 

themes in the system-wide /usr/share/

themes directory and in ~/.themes 

inside your home.

Change look and feel

Customising the desktop

02 
Ubuntu includes certain 

mechanisms for gathering 

users’ data and collecting statistics 

– of course, this is meant entirely for 

the sake of better usability in future 

Ubuntu releases. Some find this 

behaviour controversial, so let’s adjust 

it a little. In System Settings>Security 

and Privacy go to the Files & 

Applications tab and uncheck or 

maybe turn completely off files and 

applications usage statistics. On the 

Search tab you can actually turn the 

online search results in Unity Dash on 

or off. For example, if you don’t like 

shopping suggestions while looking 

for a local app on your computer, 

simply turn it off.

Change privacy settings

Ubuntu essentials
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04 
The Unity desktop lets you assign an action to any corner of the screen, 

plus to any of its sides. In order to do this, we need to access advanced 

window manager settings. Launch Unity Tweak Tool and go to Window 

Manager>Hotcorners. There are eight areas (four corners and four sides) with 

a drop-down menu next to each, letting you choose what action will be 

performed once you move your mouse to the respective area of the screen. 

You can set a corner or a side to toggle the desktop (for example, minimise all 

windows or bring them back on), spread windows or show workspaces. All 

changes are applied instantly, and you can check by driving your mouse to a 

corner or side where an action has been assigned.

Use hot corners

05 
The ‘System Tray’ area resides 

the far-right corner of the 

top bar. Some indicators can be 

configured individually but for more 

control you will need to deal with 

dconf-editor (Fig 2). This twin-panel 

app has a categories list on the left 

and the contents on the right allows 

you adjust aspects of Unity indicators. 

Go to com>canonical>indicator and 

explore the parameters of each one. 

You can turn indicator presence on 

the top bar on and off by toggling 

the ‘visibility’ parameter and change 

indicators’ display format by playing 

with ‘show-*’ parameters. This way 

you can keep your system tray area 

clean and tidy.

Rule the indicators

Customising the desktop

“Check hot corners have been applied 
by driving your mouse to a corner or side 
where an action has been assigned”

Ubuntu essentials

Fig 2 Get more customisation 
control with dconf Editor
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Discover 
System Settings
Discover system details, manage user accounts and 
coni gure hardware

The System Settings application houses various settings and acts 

the same way as the Control Panel in Windows. You can launch 

System Settings from the farthest indicator in the top bar, or even 

from the command line ($ unity-control-center). Of course, the 

set of system-related settings here isn’t the only place where you 

can change such settings, but it is the most convenient and safe 

place to do it. Traditionally in Linux (and Ubuntu is no exception), 

system settings could be changed via editing coni guration i les 

in the /etc directory, or by issuing certain commands while being 

in root. While these work in Ubuntu, it requires advanced skills 

and sometimes involves putting your Linux installation at risk. The 

System Settings shell in Ubuntu contains a limited number of neatly 

designed items that help you manage essential system-related 

settings with ease and minimum skill. The System subsection 

contains settings for Backup, System Details, Landscape Service, 

Software Sources, Time & Date, Universal Access and User Accounts. 

Some of the above are applicable for enterprise Ubuntu users 

(such as the paid subscription for technical support, which is called 

Landscape), while other settings are covered in detail in separate 

chapters (Backup, Time & Date, etc). This overview focuses on Details 

and User Accounts as well as on certain hardware-related settings.

“The System Settings shell in Ubuntu 
contains a limited number of neatly 
designed items that help you manage 
essential system-related settings with 
ease and minimum skill”

30
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Navigation
It’s not included right out of the 
box, but it is instantly available in 
the standard Ubuntu online reposi-
tory. Get it with $ sudo apt-get 
install unity-tweak-tool

Personal settings
Most settings here are user-
specific. You can also change 
look and feel settings here, 
adjust privacy, manage online 
accounts etc

Hardware settings
You might set up extra 
peripherals, input devices, 
change power settings, or even 
manage colour profiles for 
printers and displays

Search for a setting
If you cannot find the required 
settings but you know its name, 
type it into the search bar and 
see how System Settings filter 
the results according to your 
input on the fly

System-related 
settings
Backups, system details, 
updates and software sources, 
accessibility options, time 
and date and more, can be 
managed within this category

View important subsections  Conigure your Ubuntu installation
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Explore system details  
and change some defaults

Sometimes you need to know more information about your version of 

Ubuntu. Is it 32 or 64 bit? How much memory is there in your PC? In order 

to prevent you from getting lost, there is a dedicated subsection in System 

Settings that’s called Details. The main screen in Details shows a summary 

of the most important specs of your system, including CPU name and clock, 

graphics driver, hard disk volume and more (Fig 1). You can also update your 

system with the Install Updates button on the right. There are other useful 

tabs in Details – see the list on the left side of the screen. Go to Default 

Applications to change your default web browser, email client, music player 

or image viewer. Similarly, on the Removable Media tab you can define 

what Ubuntu should do when an optical disc (CD/DVD/BD) is inserted. 

Again, all changes are then applied immediately.

Manage Ubuntu users

If your PC is mainly used as a 

private or personal computer then 

perhaps you are the only user in 

the system. Here’s what you do 

you need to do if you want to 

create another user for testing 

purposes, or for guest logins. If 

there is actually already more than 

one person that accesses the PC 

(in a public place for example), 

you’ll need the correct number 

of login accounts. These are 

managed in the User Accounts 

subsection. By default, you can 

only see the list and the settings, 

but can’t change anything. To add 

or remove users you must click 

the ‘Unlock’ button and enter the 

root password. After that you’ll 

be able to click the tiny ‘+’ and ‘-‘ 

buttons displayed at the lower 

left corner of the screen, watch 

an activity log of other users (the 

History button) and toggle their 

automatic login.

Discover System Settings

“Sometimes you need to know more 
information about your version of 
Ubuntu. Is it 32 or 64 bit? How much 
memory is there in your PC? To avoid 
getting lost, head to System Settings”

32
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Tune up power settings

These settings mostly affect laptop 

users, but they can help optimise 

desktop power consumption as 

well. Under the Hardware category 

of System Settings, go to Power 

and use the first drop-down menu 

to set up the inactivity period 

– this is the period after which 

your computer will automatically 

suspend. The second option 

down lets you disable the battery 

indicator for example. When your 

laptop always runs from AC, there 

is no need for this. Another power-

related tunable is screen brightness. 

Either follow the link on the Power 

tab or open up the Brightness & 

Lock subsection directly. Here you 

can set a period of inactivity, after 

which the display will be turned off 

automatically and the computer will 

be locked. You can define whether 

the user is required to provide a 

previously set password to unlock 

the computer.

Set up a printer

Ubuntu automatically detects and 

configures local printers in case it has 

a driver for them. Most consumer 

printers are supported without any 

problems in Linux, so if you open the 

Printers subsection, you should see 

the icon for a configured printer. You 

can edit the printer’s preferences, 

change its driver, or you can create 

several instances of the same printer 

with different settings. Press the 

‘Add’ button and follow the wizard 

to set up a local or remote printer – 

much of it’s automatic (Fig 2). If you 

need more control or you want to 

resolve a printing issue, use $ sudo 

service cups restart. This is the 

command for restarting the system-

wide printing service in Ubuntu. To 

enjoy the feature-rich CUPS admin 

interface instead, try going to http://

localhost:631 in your web browser. 

Note that all changes to printer 

settings require the root password of 

your Ubuntu system.

Fig 2 (above) Ubuntu should 
automatically detect both local and 

network printers

Discover System Settings
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Tweak your 
security settings
Make sure your Ubuntu setup provides proper 
privacy protection

Privacy is a cornerstone of secure computing. Your data should 

be protected, your computer should prevent unauthorised access 

and you should be aware of the personal data that’s sent from 

your system to remote servers. Ubuntu provides a good balance 

between usability and security. For example you cannot log in to 

Unity directly; instead you can actually use the ‘sudo’ prei x to run 

commands as an administrator. For regular desktop activities there 

is the System Settings>Security & Privacy subsection, where you can 

change many settings. Most relate to password protection, keeping 

logs and history for i les and applications, online search results in 

Ubuntu Dash and diagnostics information that Canonical would 

use to i x bugs and collect users’ statistics. The reasons as to why 

you may want to change anything may vary. Maybe you don’t want 

others to see what you have been using recently or maybe online 

search results in Dash distract you. There is another security setting 

in Ubuntu outside its System Settings shell. When you launch 

Firefox for the i rst time it asks you to choose what data you’d like to 

share. By default Firefox sends crash and help reports to Mozilla, but 

you still decide and approve them.

01 
There is no sense in setting your Ubuntu password as something simple 

such as 12345678 or P@ssw0rd. It is sensible to invent a combination of 

symbols that is unique, complex, long enough and most importantly something 

that you are sure you will not forget. A good password contains lower and 

uppercase letters, special characters and digits. Thankfully, Ubuntu can help you 

deal better with stronger passwords via the APG utility. Install it with $ sudo 

apt-get install apg and run simply with $ apg. APG will prompt you to 

enter a random word of your choosing, and then converts your suggestion into a 

stronger combination of characters, but still something readable and not too hard 

to remember by heart, such as WoudElIc6 (Woud-El-Ic-SIX).

Generate a stronger password

34
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03 
Firewall is an effective tool for 

blocking network intrusions 

from the outer world and limiting 

suspicious network activity in both 

directions by blocking certain network 

packets in IPv4 and IPv6 protocols. 

Linux has the ‘iptables’ tool for doing 

this job, but it is not very intuitive for 

newcomers. Luckily, Ubuntu has a nice 

front end to iptables called UFW – the 

Ubuntu FireWall (Fig 1) in its standard 

repositories. Install it with:

  $ sudo apt-get install ufw 
gufw

You can control it either from 

command line ($ sudo ufw --help), 

or within a graphical interface (search 

for ‘firewall’ in Dash or simply launch 

$ gufw).

Enable uncomplicated 
firewall

02 
Let’s go a little further and make Ubuntu receive important security updates 

without any interaction with a user. This feature is very useful because not all 

updates are installed without your awareness, but only security-related ones that fix 

vulnerabilities, critical bugs, memory leakage and so on. To enable this feature, first 

start by installing the package along with the required scripts:

  $ sudo apt-get install unattended-upgrades.

Next, enable updates with the following command:

  $ sudo dpkg-reconfigure -priority-low unattended-upgrades.

All you have to do is to add unattended upgrades command to your Cron list on 

a daily/weekly/monthly basis. Find more details at bit.ly/1EtLKFF.

Enable automatic security updates

“A good password contains lower and 
uppercase letters, special characters and 
digits. Thankfully, Ubuntu can help you”

Ubuntu essentials

Fig 1 Enable the Ubuntu Firewall and 
tweak settings
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Protect your PC
If your PC suspends or turns 
off the display after a period of 
inactivity, you can set Ubuntu 
to require a password in order 
to resume using the PC

Choose what to 
include
There are default places inside 
your home directory for Music, 
Pictures, Downloads, etc. You 
can decide what items you 
want to include in Ubuntu 
logging. Aside from directories, 
there are also chat logs and 
office documents

Related settings
The first link takes you to the 
User Accounts subsection, 
where you can change your 
password; the second link is for 
Power settings, where you can 
change the time period before 
you system suspends

Usage activities 
record
Here is the global switch that 
triggers file and application 
usage logging. You can turn it 
off with just one mouse click, 
or alternatively decide to make 
more precise adjustments

Exclude specific 
directories  
and apps
Use the ‘+’ and ‘-’ buttons to 
select specific directories 
or applications that Ubuntu 
will not log or trace. You can 
even create sophisticated 
combinations of apps

What about online 
search results?
A rather controversial feature, 
which is why Canonical decided 
to put in the Off mode in 16.04. 
You can always change the 
trigger’s position here

Diagnostic reporting
Canonical needs your feedback 
in order to make Ubuntu better. 
If something goes wrong (eg a 
program crashes), Ubuntu will 
send details of the problem in a 
report to its headquarters

“Ubuntu provides a good balance between usability and 
security. For example you can’t log in to Unity directly; you can 
use the ‘sudo’ preix to run commands as an administrator”

Tweak your security settingsUbuntu essentials

Find the security settings  Check out the Security & Privacy tools
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Fig 2 (above) Get root privileges by 
using the ‘sudo’ prefix

04 
The ‘sudo’ is a command that you can put before another command in 

order to make it run with root privileges (Fig 2). You can use sudo anytime 

and for any command but practically you only need to do so if you haven’t got 

enough permissions with your regular user account – for managing printers, or 

in case you need to write a file into a directory outside your home for example. 

Ubuntu comes with sudo enabled by default, which lets you run any command, 

but requires entering your current password (not the root password, root is 

disabled in Ubuntu by default). You can change the sudo settings by issuing the $ 

sudo visudo command, which will open the /etc/sudoers file in the Nano editor. 

You can discover the magic of sudo with $ man sudo, but there are also instant 

solutions you can use by changing the following line:

  username ALL=(ALL) ALL

to the one below:

  username ALL=(ALL) NOPASSWD: ALL

to stop sudo asking for a password.

Configure ‘sudo’

Tweak your security settings Ubuntu essentials
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Find your way 
around Dash
The nerve centre of the desktop, these essential tips 
and tricks will have you using Dash like a pro

It is very common for people switching from a Windows platform 

to a Linux system to look for the ever-popular Start menu. Generally, 

the Start menu serves as the starting point of your interaction 

with the computer, and once you get used to it, it feels like the 

most natural way to work on the computer. Thankfully, Unity – the 

standard desktop environment for Ubuntu systems – of ers Dash.

Think of Dash as the equivalent Start menu of your Ubuntu system. 

Dash allows you to search for applications, i les, music and videos, 

and shows you items that you have recently used. Dash also helps 

you to launch application and i le shortcuts. 

To start Dash, simply click on the Ubuntu logo on the top-left 

portion of the menu bar. You can also press the super key on your 

keyboard (marked with the Windows logo) to launch it. To exit Dash, 

all you need to do is click the ‘esc’ button. 

Dash segregates the search results as a series of scopes (or lenses). 

These are used to provide views to your i les, folders, applications 

and data. There are a few basic scopes installed by default with an 

option to disable them. Switching of  a scope means you won’t 

see any results from that scope in your search results. With so many 

coni gurable features, it is evident that Dash is more than a search 

box for i nding i les, but rather it provides a view of the whole 

operating system.

“Generally, the Start menu serves as the 
starting point of your interaction with the 
computer, and once you get used to it, it 
feels like the most natural way to work”

Ubuntu essentials
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Dash scopes and lenses

Dash serves as the universal window for finding content, but as there are several 

types of content on the computer, the results are segregated into smaller scopes 

or lenses (Fig 1). Dash has a series of scopes that logically separate the results and 

provide views to your files, folders, applications and data. The following scopes are 

installed by default: Home, Applications, Files, Videos, Music, Photos and Online 

(social media). 

When you launch Dash, you’ll see a search bar on the top. This is common to all 

scopes. Simply start typing and a list of results will appear below. Note that this is the 

home lens. The home lens is the default and will appear unless you explicitly select 

another lens. You can explicitly select a lens by clicking one of the options on the 

bottom bar (when Dash is active). Other lenses will only show the items from the 

corresponding scope that is relevant to your search query. For example, if you type 

text as a search query, home lens will show the results from all over the computer, 

but if you change it to an application lens, you’ll see the text editor as the first result. 

Dash keyboard shortcuts

There are several shortcuts you can use to speed up your interaction with 

it. For example, press the super key and hold it for a while; a list of numbers 

will appear against the Launcher. You can open any of the applications by 

simply pressing the associated number on the keyboard. While you hold the 

super key, you will see a window with several shortcuts listed.

To go straight to the applications lens, simply press the super key and the 

letter A at the same time. Similarly for the music lens, press the super key 

and M at the same time. For videos, press the super key and V. 

Super key+C takes you to photo lens and Super key+F opens the file lens. 

If you would rather switch between lenses on the fly, you can use Ctrl+Tab 

to switch between lenses once you are inside Dash.

Fig 1 (above) Search results in Dash 
are separated into logical categories

Ubuntu essentials



Managing lenses in Dash

Though Dash offers a lot of flexibility in showing search results, you may wish to 

remove some of the results listed, or add some that are either hidden by default, 

or simply don’t exist. There is a small application available in the Ubuntu Software 

Centre to help you to do this. Let’s install it first. Open Dash. Change the scope 

to Applications and search for the main menu. In the results that appear, click on 

the link to the Ubuntu Software Centre. Click Install on the top-right corner of the 

page to install the software. Now, open the main menu application using the 

Launcher or Dash. 

You can now enable, disable and even permanently delete items or whole 

categories from here. Check out the categories in the left-hand column. You can 

uncheck items or categories to hide them, and check to make them searchable 

again. This will not install or uninstall any software, but just stop results from 

showing in the Dash search results (Fig 2). This way, you can be sure of not 

breaking anything important. 

Filtering Dash responses

The top-right corner of each lens has the filter option. You can click on the ‘Filter results’ 

link to expand the options. Note that the options are contextual – that is to say that 

there are options under different lenses. In the Home tab the filter option lets you 

choose which categories are shown and the online sources from where results can 

be pulled. 

The filters for the Applications tab include the ability to filter by type (such as 

graphics), games, Internet applications and so on. The filters also enable you to narrow 

down the search between applications that are already installed and applications that 

appear in the Ubuntu Software Centre. Similarly, if you are in the Files lens, you will be 

able to filter the results by type, size and the last edited time. Music lens filters by genre 

and decade. Photo lens filters based on the date that the photo was taken.

Fig 2 (above) It’s possible to 
customise your Dash search results 
using the Ubuntu Software Centre

Find your way around DashUbuntu essentials
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Text area
This is the space where 
you type your queries into 
Dash. As you type in the 
text, you will see the space 
below being populated 
with results dynamically

Applications
This section displays results 
related to the applications 
scope. You’ll see all the 
applications that match the 
search query here

Weather
Dash automatically detects the 
scopes that may be relevant to 
the search query. Since there is a 
place called Dash, it automatically 
displays the weather forecast for 
that location

More suggestions
This is the section that displays 
results from online shopping 
websites and other sources 
that are relevant to the search 
query entered

Reference
This is the Dash result section 
that displays references related 
to the search query. You can 
see the definition, images and 
more related to the search 
query here

Scopes
Dash, by default, shows results 
from all the available scopes. 
You can limit the results to 
specific scopes by selecting 
them here

Categories
You can select the categories 
from which you’d like to 
view results by choosing the 
categories here

Sources
This section allows you to 
select the sources from where 
Dash will look for results when 
you enter a search query

“The top-right corner of each lens has the ilter option. You can 
click on the ‘Filter results’ link to expand the options. Note that 
the options are contextual”

Find your way around Dash

Navigate the Dash display  Get familiar with the display and ilter options
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Understanding 
the file system
Learn about the i le system in Ubuntu to keep 
everything organised

One of the most complex things about any Linux-based computer 

is probably its i le system. There are so many i les and folders that 

serve so many dif erent purposes. To a newcomer just getting 

started with Linux, all this appears like a huge maze. This calls for a 

basic, yet clear understanding of how i les and folders are organised 

in Linux, and specii cally Ubuntu. This is exactly what we are going 

to do in this guide. Let’s start with the basics.

Ubuntu (like all Unix-like systems) organises i les in a hierarchical 

tree, where relationships are thought of in terms of child and 

parent. Directories can contain other directories as well as regular 

i les. Any element of the tree can be referenced by a path name 

– absolute or relative. An absolute path name starts with the 

character ‘/’ (identifying the root directory, which contains all 

other directories and i les), then every child directory that must be 

traversed to reach the element is listed, each separated by a ‘/’ sign. 

A relative path name is one that doesn’t start with ‘/’; in that case, 

the directory tree is traversed starting from a given point, which 

changes depending on context, called the current directory. The 

fact that all i les and directories have a common root means that, 

even if several dif erent storage devices are present on the system, 

they are all seen as directories somewhere in the tree, once they are 

mounted to the desired place.

“There are so many i les and folders that 
serve so many dif erent purposes. To 
a newcomer just getting started with 
Linux, all this appears like a huge maze”
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First column
The first character indicates 
whether it is a directory or 
a file. The other nine characters 
indicate the permissions 
for file owners, groups and 
everybody else

Second column
This column indicates the 
number of links or directories 
inside the directory

Third & fourth 
column
The third column shows the 
owner of the file, and the 
fourth column indicates the 
groups that the file belongs to

File listing command
‘ls’ lists all the files in the 
current directory and the ‘-la’ 
extension shows the files in 
long format, along with all the 
hidden files. When executed 
from the root directory, it 
shows all the directories in the 
top-level hierarchy

Special files
Wherever you issue the ‘ls’ 
command in Linux, you’ll see 
these two files listed on the 
top. However, these aren’t 
visible if you inspect the same 
directory via the GUI. The 
single dot indicates the current 
directory; double dot, the 
parent directory

Fifth column
This column shows the size 
in bytes. You may modify 
this by using the ‘-h’ option 
together with ‘-l’; this will have 
the output in kB, MB and GB 
for a better understanding 
of the size

Sixth column
This shows the timestamp 
of the last modification of 
the directory

File names
This is where all the directory/
file names are listed. You can 
see all the top-level Linux 
default directories here

“Ubuntu (like all Unix-like systems) organises iles in a 
hierarchical tree, where relationships are thought of in terms of 
child and parent”

Ubuntu essentials
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Fig 1 (above) Explore Ubuntu’s file system 
arrangement using the terminal

02 
Unix abstracts the nature of tree hierarchy entirely, and the root directory is 

the base of all the folders in the Ubuntu hierarchy. Indicated by the ‘/’ sign, 

the root directory contains all the other folders (Fig 2). Though the root directory 

is conventionally referred to as ‘/’, the directory entry itself has no name – its name 

is the empty part before the initial directory separator character (/). All file system 

entries, including mounted file systems, are ‘branches’ of this root. It is because 

of this layout that all the absolute paths in Unix systems start with ‘/’. Even if there 

are several physical or virtual storage devices attached to your computer, all the 

folders will be shown under the root directory. 

Note that this is not to be confused with the /root directory that serves as the 

home directory for the root users.

The root directory

01 
The Ubuntu file system is based on the Filesystem Hierarchy Standard 

(FHS). This defines the main directories and their contents in Linux 

operating systems (Fig 1). For the most part, it is a formalisation and extension 

of the traditional BSD file system hierarchy. The Linux Foundation – a non-profit 

organisation consisting of major software and hardware vendors, such as HP, 

Red Hat, IBM and Dell – maintains the FHS. At the time of writing, the current FHS 

version is 3.0, released on 3 June 2015.

Filesystem Hierarchy Standard

Understanding the file system
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03 Let ‘s now see the various important directories present under the root directory and get an idea of which ones 

serve what purpose. 

/bin is a place for most commonly used terminal commands, such as ls, mount, rm, etc.

/boot contains files needed to start up the system, including the Linux kernel, a RAM disk image 

and bootloader configuration files.

/dev contains all device files, which are not regular files but instead refer to various hardware devices on the system, 

including hard drives.

/etc contains system-global configuration files, which affect the system’s behaviour for all users.

/home this is the place for users’ home directories.

/lib contains very important dynamic libraries and kernel modules.

/media is intended as a mount point for external devices, such as hard drives or removable media (CDs, DVDs etc).

/mnt is also a place for mount points, but it is dedicated specifically to ‘temporarily mounted’ devices such as network 

file systems.

/opt can be used to store additional software for your system which is not handled by the package manager.

/proc is a virtual file system that provides a mechanism for the kernel to send information to processes.

/root is the superuser’s home directory; it’s not in /home/ to allow for booting the system even if /home/ is not 

available.

/run is a temporary file system available early in the boot process where ephemeral run-time data is stored. Files under 

this directory are removed or truncated at the beginning of the boot process. 

/sbin contains important administrative commands that should generally only be employed by the superuser.

/srv can contain data directories of services such as HTTP (/srv/www/) or FTP.

/sys is a virtual file system that can be accessed to set or obtain information about the kernel’s view of the system.

/tmp is a place for temporary files used by applications.

/usr contains the majority of user utilities and applications, and partly replicates the root directory structure, containing 

for instance, among others, /usr/bin/ and /usr/lib.

/var is dedicated to variable data, such as logs, databases, websites and temporary spool (email etc) files that persist from 

one boot to the next. A notable directory it contains is /var/log, where system log files are kept.

Various directories under /

Understanding the file system Ubuntu essentials

Fig 2 You may be more 
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Sharing files in Ubuntu

Sharing files in 
Ubuntu
Learn to create i le servers to share data from your 
Ubuntu system

The default Ubuntu i le manager Nautilus of ers an easy-to-use 

interface to help you share i les across systems. Behind the scenes, 

however, Samba is running the show.  

Samba is a software suite for seamless i le and print services. It 

implements the Server Message Block (SMB)/Common Internet File 

System (CIFS) protocol for Unix systems, supporting i le and printer 

sharing across Windows, OS X and other Unix systems.

Samba is freely available, unlike other SMB/CIFS implementations, 

and so is widely used on various systems. You can facilitate the i le 

sharing between Ubuntu and Windows computers by coni guring 

Samba as a i le server on one of the systems.

Samba can do several other things including acting as a server 

for SMB clients: you can share printers, including PDF pseudo-

printers so all the computers in your network may write PDF i les. 

Samba can also act as a domain controller in a Windows network 

(authenticating users, and so on) and even help using a Windows 

domain controller to authenticate the users of a Linux/Unix 

machine. However we will focus only on the i le sharing aspect of 

Samba in this feature.

Samba is not installed by default in Ubuntu 16.04 and so to start 

i le sharing you’ll have to install Samba. We’ll see the installation 

process and the steps to set up i le sharing in next sections.

“You can facilitate the i le sharing 
between Ubuntu and Windows 
computers by coni guring Samba as a 
i le server on one of the systems”
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01 
To share a directory, you must have permission to access the directory. For 

demonstration purposes, let’s take a folder from the user’s home directory, 

such as Documents. 

Go to your home directory. Right-click on the Documents directory and in 

the pop-up menu, select Local Network Share. Then check the ‘Share this folder’ 

checkbox. If Samba is not installed, you will get a pop-up menu: ‘Sharing service is 

not installed’. Select ‘Install additional software’ and then click Install (Fig 1). If you 

get an error message that the samba .deb could not be found, open a terminal 

and update apt-get like this:

  $ sudo apt-get update

Try again and Ubuntu will download and install Samba. Let’s try sharing the folder 

again. Right-click on the Documents directory and in the pop-up menu, select 

Local Network Share. Next, check the ‘Share this folder’ checkbox. And then click 

the Share button. That’s it; the directory should now be shared and accessible 

from Samba clients. You can also install Samba GUI for Ubuntu. Just type:

  $ sudo apt-get install system-config-samba

…or search for Samba in the Ubuntu Software Centre and install it from there. 

Once installed, just search Dash for system-config-samba.

Samba server configuration

Ubuntu essentials

Fig 1 (above) Install Samba 
with just one mouse click



Fig 2 (above) Use the configuration 
file to enable sharing

03 We have learnt about sharing files via the GUI, but directly editing the 

configuration file gives you several more options and flexibility to implement 

things exactly how you want to. So, let us now learn how to enable sharing via the 

configuration file. The main Samba configuration file is located in /etc/samba/smb.

conf (Fig 2). The default configuration file has a significant number of comments 

in order to document various configuration directives. First, edit the following key/

value pairs in the [global] section of the config file:

  Workgroup = EXAMPLE
  Security = user

Note that the ‘security’ parameter is further down in the [global] section, and is 

commented by default. Also, change the ‘workgroup’ value from EXAMPLE to 

something that better matches your environment. Then, to share a directory, create 

a new section at the bottom of the file, or uncomment one of the examples:

  [share]    
  comment = Ubuntu File Server Share       
  path = /srv/samba/share        
  browsable = yes          
  guest ok = yes     
  read only = no         
  create mask = 0755  

Let’s look at the meaning of each section… 

comment: a short description of the share. You can adjust it to fit your needs.

path: the path to the directory to share. This example uses /srv/samba/

sharename because, according to the Filesystem Hierarchy Standard (FHS), /srv is 

where site-specific data should be served. Technically, Samba shares can be placed 

anywhere on the file system as long as the permissions are correct, but adhering to 

standards is recommended.

browsable: enables Windows clients to browse the shared directory 

using Windows Explorer.

Samba configuration file
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02 Ubuntu and Gnome make it 

easy to access files from a Samba 

server share. To start with, go to the files 

explorer and locate the ‘Browse Network’ 

link on the left vertical menu bar. Open 

this link and you will see a Windows 

network icon. Double-click to open it. 

The next window shows all the domains/

workgroups found on your network. 

Inside each domain/workgroup you will 

see all the computers on the domain/

workgroup with sharing enabled. 

Double-click on a computer icon to 

access its shares and files.

Samba clients
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Standard toolbar
In the top-right you will find 
quick links to settings, add file 
and help options

Shared files
Here you can see the list of 
all the files that are available 
under Samba sharing

Permissions
If you’d like the directory you are 
sharing to be writable/visible, just 
tick the corresponding checkboxes

Menu bar
This section has the basic settings to add 
files to share and set preferences like 
server group and view all Samba users

Share name
You can set the name for the 
directory selected above in 
this section

Save or cancel changes
Click OK in order to save the changes to the 
Samba configuration file and start sharing. If 
you hit Cancel, the changes are discarded 

Description
Set the description for the 
shared directory here

Samba share directory
Once you click on ‘Add file to share’, 
you’ll get a pop-up. In the Directory 
section, just browse and select the 
directory you’d like to share

Sharing files with Samba GUI  Learn to share iles with Samba

guest ok: allows clients to connect to the share without supplying a password.

read only: determines if the share is read only or if write privileges are granted. 

Write privileges are allowed only when the value is no, as is seen in this example. If 

the value is yes, then access to the share is read only.

create mask: determines the permissions new files will have when created.

Now Samba is configured, the directory needs to be created and permissions 

changed. In a terminal, enter:

  $ sudo mkdir -p /srv/samba/share  
  $ sudo chown nobody:nogroup /srv/samba/share/   

Finally, restart Samba to enable the new configuration:

  $ sudo restart smbd 
  $ sudo restart nmbd
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Manage drives 
with Disks
Manage hard drives, SSDs and removable media 
with Ubuntu’s Disks tool

Disks manages both local and removable drives, repartitioning 

them as well as doing backup images and restoring from them. It 

is quite a straightforward tool, with device list on the left and the 

currently selected device’s details on the right. You can use it to i nd 

out the model and size of your hard drive, how many partitions it 

has, its serial number, health status (SMART) and more. Users often 

launch Disks when they need to do some manipulations with the 

hard drives, SSDs or removable mass storage with the USB interface. 

Its illustrative visualisation of a drive’s volumes is really useful. If 

you are not aware about Primary or Extended partitions, you will 

instantly catch the idea after looking at the graphical scheme under 

the ‘Volumes’ label in Disks. You can do many advanced tasks with 

just a few mouse clicks, such as benchmark your drive, put it in a 

standby mode, create or delete partitions and so on.

Another tool in Disks is its ability to create images from drives 

(*.img) and to restore such images into other drives. This feature lets 

you clone all data, logical structure and a bootloader to, say, a newly 

acquired hard drive that you wish to use as a replacement drive.

01 
Sometimes new hard drives arrive with no partitions at all and Disks will 

show them as a monotonous rectangle labelled as ‘Unknown’. You may 

now choose what you want to do. if you go with an upper ‘gear’ button and 

format the whole disk, you will only create a partition table, not volumes. There is 

the legacy MBR (Master Boot Record) type, and the modern GPT (GUID Partition 

Table). The first one is compatible with everything, the other is required by new 

PCs with UEFI boot and also by large disks (>2TB). Next, you may want to create 

the actual volume by clicking on a volume-specific ‘gear’ button below and again 

choosing the Format option. If you plan to access your disk from Windows, use 

the NTFS filesystem. Otherwise, for Linux-only usage, the best option would be to 

go with Ext4.

Format a USB portable drive
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“Users often launch Disks when they need to do some 
manipulations with the hard drives, SSDs or removable mass 
storage with the USB interface”

See what is 
connected
Disks shows you all connected 
drives that it can support (and 
that is almost everything). The 
Devices bar lets you select 
multiple drives and apply 
some actions to multiple drives 
at a time

Separate controls for 
each partition
This tiny button only works 
for the currently selected 
partition. It actually allows 
you to unmount or deactivate 
a partition and provide a set 
of options for formatting, 
removing and benchmarking

Linux filesystem
Here you can see the drive 
name as well as its size. The 
bold label shows you the 
total capacity of the currently 
selected drive, while the next 
line shows the name of the 
drive, which you can address in 
console commands

More details
These helpful five lines show 
you the selected drive’s model, 
size in bytes, partitioning type 
(MBR or GPT), serial number 
and assessment information

Partition details
Once you select a partition, you 
can see its name, size, available 
free space, filesystem type and 
mountpoint. Click the link to 
open the partition contents in 
Ubuntu’s file manager

Volumes count and 
drive structure
Here you can find out how your 
drive is partitioned, whether 
there are any extended 
volumes or a swap partition. 
The size of the rectangles 
corresponds to the size of the 
respective partitions

Extra  
features
The ‘gear’ button hides lots of 
extra features, including options 
for creating and restoring disk 
images, benchmarking tool, 
drive settings dialog and if 
supported, SMART self-tests

Manage your drives  Disks ofers a very neat layout with lots of powerful features
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Fig 1 (below) Disks’ Benchmark tool 
will analyse your drive’s performance

02 
Conducting performance tests is fun but challenging, especially for non 

tech-savvy users. The Disks application in Ubuntu has a built-in tool that 

means you can benchmark your drive for read and write speed at any time. First 

you need to unmount either all volumes (for the whole drive), or a volume you’d 

like to test. For that reason, you cannot benchmark the root partition of your 

current Ubuntu system, but there are no other limitations for the rest. Click on the 

‘gear’ tab and select the ‘Start Benchmark’ option and then ‘Start Benchmarking’. 

You’ll get a graph with the red curve for average write rate, blue curve for read 

rate and green spots for access time (Fig 1). It can help you detect a dying drive 

before it is too late, and also to compare real-world specs of the newly bought 

drive with its whitepaper.

Benchmark your drive

Manage drives with Disks
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Fig 2 (below) Use Disks to apply 
timeout settings on your system

04 
A hard drive image is a very handy thing compared to plain file backups. 

It stores all drive structure, bootloader records and all other drive details, 

letting you replicate your setup onto another physical drive. Again, in case of an 

ageing drive, which you feel can break at any time, there’s no better way to save 

it other than create an image. Depending on what ‘gear’ button you use, you 

can either create an image of the whole drive, or just the current partition. When 

you choose the ‘Create Disk Image’ option, Disks will prompt you to choose a 

destination directory for the image file. Note that it must be saved on another 

physical drive. Later on you’ll be able to restore the drive form the image file using 

the ‘Restore Disk Image’ option.

Create an image and restore from it

03 
Drive settings can be sensitive to both desktop and laptop computers. 

Putting a drive into standby mode not only helps save some watts but 

also reduces heating, and even makes the system quieter. Regardless of the 

default behaviour of your drive in Ubuntu, you can explicitly set it to go to sleep 

after a certain length of time. Click on the ‘gear’ icon and go to Drive Settings, 

where you can move the ‘Apply Standby Timeout Settings’ switcher to the ‘on’ 

position. Now you drag the slider and set the preferred timeout value, after which 

the drive will go on to standby (Fig 2). Similarly, you can decide whether you want 

to enable or disable write caching – just go to the ‘Write Cache’ tab and choose 

the desired mode. When caching is enabled, your drive works faster but may get 

corrupt your files in case of power outage.

Adjust drive standby settings

Manage drives with Disks Ubuntu essentials
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Get to grips 
with the Linux 
command line
Well-chosen words can save you jumping through 
GUI hoops, so ensure you use the right commands

The command line may be an older interface, but the reason 

it’s survived is the power to tell the computer, in a few apposite 

commands, exactly what you want. For example, a single command 

can copy all of the MP3 and MP4 i les in a directory to a backup 

disk or a machine elsewhere on the network – or anywhere else on 

the Internet.

Many people’s i rst encounter with a computer – perhaps at 

university in the 1970s or 1980s – was seated at a dumb terminal, 

known as a console, connected to a distant, and very large, 

computer. Nowadays, computers can be the size of a credit 

card – like the Raspberry Pi – but the old-fashioned terminal is 

remembered in the form of the terminal program that gives you a 

command-line interface to Ubuntu.

Depending on which l avour of Ubuntu you are running, the 

terminal may have a dif erent name, but type ‘term’ into the app 

search of Unity Shell, or your menu, and you will bring up at least 

one choice of terminal. Open this up and you should see a fairly 

empty-looking window. Don’t be scared of that blinking cursor – 

usually the ‘$’ sign, known as the ‘dollar prompt’. It’s waiting to do 

whatever you tell it. You just need to know the right words – or 

commands – to get it going. 

Here’s an easy one for you to try i rst: type evince into the 

terminal - we’ll put the instructions you need to type into bold, so 

you can see commands more clearly; always press Enter afterwards, 

to let Ubuntu know it’s now got to do something. 

Provided you didn’t mistype, you’ll have just opened Ubuntu’s 

PDF reader, without using a GUI menu or shortcut item.
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Fig 1 (left) The mv command is 
used in order to move files from one 
location to another

To look inside your Documents folder, open a terminal and type ls Documents. 

Don’t forget to press Enter. You’ll see a listing of all of the files in Documents. Type 

ls and you’ll see a listing of the files in your home directory – that’s because 

when you open a terminal, it places you in that directory. You can change by 

using the change directory command – cd – like this: cd Documents. Now ls 

alone will show you your files.

The cd- command will take you back, because the ‘-’ is a shortcut to tell cd to 

go back to where you were before. You could also type cd ~, as ~ is short for your 

home folder – /home/jo/ or whatever. pwd will remind you where you are now.

Configuration files – the ones called dotfiles, because their names are prefixed 

by a dot – are normally hidden from listing. In most file managers you can toggle 

them into view with Ctrl+H (on a few, it’s Ctrl+.). At the terminal, it’s ls -a.

The . and .. are shortcuts to ‘this directory’ and ‘parent directory’, or the one 

above – hide them by using -A in place of -a. Those letters after the hyphen are 

called command-line switches: try ls -l, for long listing. We’ll tell you about 

some of that cryptic-looking info it displays later.

Moving and copying files uses mv and cp commands. We’ll see cp in use 

overleaf, but for now we will replicate Fig 1 and attempt to move our files to a 

new location:

  cd ~
  touch random.txt
  mv random.txt newname.txt
  mv newname.txt Documents/
  ls
  ls Documents

Files, folders, and familiar things
Time to get the command line working for you, on 
your i les and folders

Look Inside

You don’t need to open an 

application to look inside a file. 

The file command will let you 

see what sort of file it is. cat 

sends the contents of the file 

scrolling by, or more gives them 

to you a page at a time. less 

does the same thing, with more 

controls, and leaves you stuck if 

you don’t know to press Q to quit. 

Q will also exit man pages; for 

other apps, Ctrl+C is a good bet 

for quitting. Sometimes you just 

want to see the first or last few 

lines of a file – head and tail are 

the commands you need, each 

defaulting to ten lines. tail -n 

30 /var/log/syslog shows you 

the last 30 things registered by 

that log file. Real power comes 

with grep (Fig 2, page 56), to 

search for a term inside a file. Try 

grep ls ~/.bash_history to 

pull out all the instances of ls that 

you have used so far.

Ubuntu essentials



Tab complete

If you think that’s a lot of typing, try hitting the Tab key after a couple of 

letters of each word. Where there’s only a single possible completion, the 

word will be automatically filled in. Two tab clicks brings up suggestions 

where there are multiple possibilities.

If you want to know more about a command, they (almost) all have 

manuals – or man pages (Fig 3). man ls will tell you all about options for ls; 

ls will tell you about the manual command itself.

Fig 2 (above) The grep command enables 
you to search for terms inside files

Fig 3 (right) Most commands have 
manuals, accessed with the man command
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Using Nano

Looking inside a file is all very well, but often we need to quickly change 

something inside it. 

In this example, we’re going to use Nano, a command-line text editor (Fig 

4). There are many more powerful editors – and many a little friendlier, too 

– but Nano is included in Ubuntu, and many other flavours of Linux, so it’s 

handy to know the basics.

We’ll edit the ~/.bashrc file, a collection of customisations for the shell 

environment; don’t worry that much of it won’t yet make sense. To offset 

the risk of damage to your command environment, back up the file first: cp 

.bashrc .bashrc.bak – then nano .bashrc. 

Find the section with the alias commands near the end. Note that the 

ones with a # in front of them are inactive (said to be commented out) 

– remove the # to get one to work next time you log in or open a new 

terminal session.

You can use the arrows to navigate to the text you want to edit; delete 

and type in new text as required. Nothing too strange so far, until you’ve 

finished: note those two lines at the bottom of letters preceded by a ^ 

(caret). These are the keyboard commands – the ^ represents the Ctrl key – 

type ^O (hold down the Ctrl key and hit O), and your work will be saved; hit 

^X and you’ll exit Nano.

You can set a temporary alias directly, which will last until you close the 

terminal down (Fig 5):

  alias myplace=’ls -lAhF /home/richard/’

Fig 4 (above) Nano is included in 
Ubuntu and most other Linux distros 
by default
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Permissions, please

Ubuntu files are protected from alterations by other users on a shared 

machine. All files and folders belong to a user – it doesn’t have to be a person, 

it could be a piece of software, like a web server – and a group. Permissions 

on each file relate to whether a user, group or anyone else can read, write 

or execute the file; this is abbreviated as rwx permissions. For directories, 

execute permission is just permission to open. Execute a file means run it as 

a program – so a JPG picture file doesn’t have permission to run, nor does 

a spreadsheet file, meaning the embedding inside one of malicious code is 

much harder to accomplish for virus writers.

From whichever directory you are currently in, create an empty file – 

touch testfile will do the trick – then ls -l. The long listing shows you 

permissions (see opposite), and you can see the default permissions of a 

newly created file. Enter mkdir testfolder and you can see the permissions 

of a newly created directory. Remove the file with rm testfile – you’ll need 

the recursive switch to remove a directory: rm -r testfolder.

No attachment?

While the protection offered by permissions is very useful, they are also 

there to trip up the unwary. For example, using sudo, you may have copied 

files from another user’s home folder. Unless you change the ownership 

(see opposite), you may be left scratching your head when you try to attach 

the files to an email, and they just won’t stick – because you don’t even 

have permission to read the files!

Fig 5 (above) Setting a temporary 
alias means it will last until the 

terminal is closed

58

Get to grips with the Linux command lineUbuntu essentials



59

“Permissions on each i le relate to whether a user, group 
or anyone else can read, write or execute the i le; this is 
abbreviated as rwx permissions”

Long listing
Running ls -l lets you see who owns 
a file or folder, and who has permission 
to read, write and run software. Three 
groups of rwx in the listing apply, 
respectively, to the named user, the 
named group, and everyone else left

Give me the file
If you’ve copied a file into your folder 
using sudo, you may have left it with 
root ownership. Change the ownership 
with chown jo myfile.txt – for 
example – and the group with chown 
:audio myfile.mp3. Fill both sides 
of the ‘:’ to change user and group 
ownership together

Octal code
The rwx – read / write / execute 
permissions – are given respective 
values of 4, 2 and 1. To give a file read 
+ write + execute permissions, 4, 2 and 
1 are added to give 7. For just read and 
execute, 4 + 1 = 5. Applying the former 
to user and group, and the latter to 
‘other’, chmod 755 file.txt.

Run with it
A file becomes a program when it can 
be run. You write or download a shell 
script, say backup.sh, and try to run it 
- ./backup.sh – and nothing happens. 
You need to give it executable 
positions: to save the octal adding, you 
can just chmod u+x backup.sh. You 
can also call it with sh backup.sh.
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Give me more software

Despite every flavour of Ubuntu having a graphical program to install 

software onto the system, you’ll usually see projects supplying the 

command-line way of getting their software. The reason for this is that the 

command-line instructions are direct and unambiguous. Let’s try it out, and 

you’ll see what we mean.

Ubuntu, as you may have read elsewhere within these pages, is based 

upon Debian, one of the earliest GNU/Linux distributions, dating back 

to 1992. It’s an open collaborative project between over a thousand 

developers across the world co-operating over the Internet, which has 

contributed to its longevity. So too has the Debian package management 

system, and the command-line program to manage fetching and installing 

the packages. Apt – the Advanced Package Tool – keeps track of all of the 

software in Ubuntu’s repositories, and takes care of any dependencies on 

other packages when you install. It’s what the Ubuntu Software Centre uses 

behind the curtain of that graphical interface.

Every step that involves installing software on your system needs root, or 

superuser, permissions: on Ubuntu this is done by prefixing the command 

with ‘sudo’. On some other systems you would log in as root user; you can 

temporarily do this on Ubuntu by running sudo -s or sudo bash, but we 

don’t recommend it, as it’s easy to get into the habit of running with root 

permissions, and to accidentally cause some damage. 

Update Ubuntu’s knowledge of the latest available packages with 

sudo apt-get update. You can look under /etc/apt/ to see the source 

files where Ubuntu remembers which repositories to look in. You can 

Fig 6 (above) The Linux command 
line may seem complicated at first 

but you will soon master it
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Fig 7 (above) Use the command line 
to manually add a new repository

“Apt – the Advanced Package Tool 
– keeps track of all of the software in 
Ubuntu’s repositories, and takes care of 
any dependencies on other packages”

Get to grips with the Linux command line

edit these manually to add more, and to change version for upgrading 

(proceed with care!). But the simplest way to add a new repository is with 

apt-add-repository: sudo apt-add-repository ppa:jon-hedgerows/

get-iplayer. After which you’ll need to run sudo apt-get update again, 

before installing from the repository: sudo apt-get install get-iplayer 

(Fig 7). The get-iplayer script is a command-line piece of software for 

timeshifting BBC radio (and TV) programmes; apt-get upgrade will install 

all of the security updates and bugfixes that have been made recently. 

This is something you should run regularly (but to save you the trouble, 

Ubuntu tells you that updates are available, and regularly asks permission to 

get them). Run apt-cache search terminal to find alternative terminal 

programs, and apt-cache show eterm to examine one of them. Now you 

know the basics, explore a little more.

Ubuntu essentials
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Use GNOME 
Terminal & 
Xterm
Explore the basics and benei ts of the terminal 
emulators in Ubuntu

Ubuntu ships with two terminal emulators. One is GNOME Terminal, 

a widely used program and probably the only known terminal 

application for many Ubuntu users. GNOME Terminal is one of many 

GTK-based apps that Unity desktop shares with GNOME Shell – 

many tools and accessories are the same in Unity and GNOME. 

GNOME terminal looks clean and minimalist, but it has enough 

settings that let you coni gure this small application to suit your 

needs and tastes. Choose Edit>Proi le Preferences to edit the current 

‘Default’ proi le for the sake of dif erent behaviour or a custom look 

and feel. GNOME Terminal makes interaction comfortable between 

graphical applications and the Bash shell thanks to the support of 

drag and drop for text strings, copy and paste with both keystrokes 

and context menus, and mouse scrolling in terminal mode.

Xterm is entirely dif erent; it is a tiny, old-school thing that hasn’t 

changed much since 1984, and was initially developed before the 

X Window System saw the light. Xterm uses the same Bash shell 

as GNOME Terminal does, so the commands behave in exactly the 

same way in both terminals. Xterm is very helpful in an emergency; 

if your main desktop fails to load and you just need to get to 

graphical mode, use something like $ xinit xterm. It never breaks!

“GNOME terminal looks clean and 
minimalist, but it has enough settings to 
tailor to suit your needs and tastes”
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01 
Every Linux distribution uses Bash (Bourne-again shell) in text mode and 

graphical mode within a terminal emulator, including Xterm and GNOME 

Terminal. Bash has a very rich set of supported commands, but the most useful 

feature comes from its popularity; all Linux users use their terminals with the 

same syntax. However, there are other shells – such as a highly customisable ZSH 

with an even wider feature set, or CSH with a built-in scripting language – that 

have similarities with the C language. To change the default shell from Bash to 

something else in GNOME Terminal, go to Edit>Profile Preferences, switch to the 

Title and Command tab, enable the ‘Run a custom command instead of my shell’ 

option and put the name of your desired shell in the Custom Command field.

Change Bash to something else

02 
Let’s make the GNOME Terminal look a little more personal by changing 

text font, colour and background (Fig 1). Go to Edit>Profile Preferences and 

switch to the Colors tab. Uncheck the ‘Use colors from my system theme’ option 

and choose any combination of colours for text, text in bold and background. 

There is a list of good presets in the ‘Built-in schemes’ drop-down menu; it can 

save you from an agony of choosing. To change the font itself, go to the General 

tab and uncheck the ‘Use the system fixed width font’. After that, you’ll be able to 

select another Mono font.

Change fonts, colours and background

Fig 1 (above) Personalise your 
GNOME Terminal by adding colour

Ubuntu essentials



Edit your 
terminal profile
Change the title, cursor 
shape, scrolling options and 
command behaviour, as well 
as colours, fonts, some historic 
legacy stuff (like Backspace 
and Delete-key behaviour) 
and more

The icon says it all
You won’t confuse Xterm with any 
other terminal emulator thanks 
to that distinctive icon, boasting 
support for 256 colours on that 
expressive cathode-tube display

Enjoy the convenience of  
GNOME Terminal
GNOME Terminal fits well into the 
Ubuntu design with its recognisable 
Ubuntu Mono font and deep-purple 
background. However, you can 
change these and other settings with 
several mouse clicks

Non-distracting 
scrollbars
GNOME Terminal drew ugly, 
thick scrollbars in the past. 
Sometime later, Canonical 
applied its overlay bars, and 
removed the 1-pixel outline 
around the terminal frame

Try a fail-safe 
solution
Xterm is relatively old, 
however, it delivers a pure Bash 
experience without any bells 
and whistles. Xterm comes in 
every OS that uses X.org (all 
Linux distros do)
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“Bash has a very rich set of supported commands, but the 
most useful feature comes from its popularity; all Linux users 
use their terminals with the same syntax”

Use GNOME Terminal & Xterm

Save yourself time  Working with terminal emulators is easier than you’d think
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04 
Working in the terminal goes long into the history of Linux and UNIX, 

so it’s no wonder we have a decent number of discovered Easter eggs 

and jokes that bring in some fun and help you to feel more comfortable in the 

terminal. Start with $ sudo apt-get install moo to bring up a jolly cow (Fig 2), 

find another Easter egg with $ aptitiude moo and then $ aptitude --v moo 

and add an extra ‘v’ three more times to see a snake that has eaten an elephant. 

The $ sl shows a steam locomotive and finally the $ fortune | cowsay 

shows a cow that tells your fortune. However, to finish up, let’s do something 

massive and change our boring GNOME Terminal to a Hollywood Technodrama 

showcase, mimicking an FBI command centre (Fig 1, page 63):

  sudo apt-add-repository ppa:hollywood/ppa
  sudo apt-get update
  sudo apt-get install Hollywood

Have some fun

03 
Knowing tricks for GNOME Terminal in Ubuntu can save time and increase 

productivity. We start with the simplest: launch the application using the 

Ctrl+Alt+T sequence anywhere in Unity. When browsing your files in Nautilus, 

it is useful to open a terminal window for the current directory. Nautilus can do 

it when you right-click on an empty space within a view area and select ‘Open 

in Terminal’, but this feature is not enabled by default in Ubuntu. Fix it with the 

following command:

  $ sudo apt-get install nautilus-open-terminal

then restart the file manager. When you need to copy or paste text, use Ctrl+Ins 

and Shift+Ins respectively, instead of laboriously right-clicking menus. To clear 

the input, you can either cancel a command with Ctrl+C, or clear what has been 

written with Alt+R.

Learn some helpful shortcuts

Use GNOME Terminal & Xterm Ubuntu essentials

Fig 2 (left) Perform the $ fortune | 
cowsay command and see this guy
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Secure files with 
Déjà Dup

Having a backup copy of your photos, documents, music and video 

i les is a high priority to keep them safe, even though some novice 

users opt to skip the process. Imagine that something has gone 

wrong with your hard drive and it can no longer boot up. The bad 

news is that while you can buy a new hard drive, you may well lose 

your data on the old one, which is often more precious than any 

hardware you might have lost. 

So here comes the i nest hour for a backup copy that you have 

prepared beforehand and kept updating regularly. And there’s no 

excuse not to do it, since Ubuntu includes a great tool for automatic 

and hassle-free backups called Déjà Dup – also known by the 

simpler name, Backups.

Using Déjà Dup is as simple as it can be: you choose what you 

want to back up and where, opt to specify what directories it should 

skip and then put the task into the automatic queue of the Ubuntu 

scheduler, which can perform backups periodically and even keep 

new and older backups at the same time. The interface of Déjà 

Dup has a category tree on the left and a main part to the right, 

with a clear arrangement of easy-to-use controls. The default setup 

assumes you might want to back up your ~/home directory with 

an exception for Trash and ~/Downloads, so you may leave it intact 

and go ahead with this safe assumption, or opt to customise the list 

of included and ignored directories to your liking.

Create an extra copy of your valuable data
and keep it updated

“Having a backup copy of your photos, 
documents, music and video i les is a 
high priority to keep them safe”
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Check destination
Déjà Dup stores backed up files in the 
form of archived files that can be handled 
with the Duplicity utility. You can’t extract 
the files with a regular unarchiver

Decide to go more secured
When a backup process starts, the wizard 
prompts you to set a password. You may 
choose to protect your backup copy with 
it, or opt to go without any passwords

Proceed with 
important routines
Choose where you want to store a 
backup copy and optionally define what 
directories you want to ignore and not 
include in the backup

Overview your backup
The starting screen in Déjà Dup shows when the 
last backup copy was made and when the nearest 
next backup will take place. There’s also a link that 
triggers the automatic backups switch

Choose manual or auto mode
By default, Déjà Dup doesn’t enable automatic 
backups right away, but you can trigger this 
switch and if you set the rest of the routine 
correctly, you’ll get unattended backups

Set up scheduling
Here you can select the frequency of regular 
automatic backups. Depending on your 
workflow, choose daily or weekly backups and 
also set the time for keeping older backup copies

“There’s no excuse not to do it, since Ubuntu includes a great 
tool for automatic and hassle-free backups called Déjà Dup – 
also known by the simpler name, Backups”

Secure your data quickly  Déjà Dup is an intuitive app for managing backed up iles
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01We most commonly seek 

to back up photos, videos, 

office documents and application 

settings. While this is true for home 

computers, let us also complement 

this with targets that are more relevant 

to production servers and corporate 

usage in general, such as databases, 

dumps, collected data files and so 

on. Always evaluate the size of the 

proposed backup beforehand and 

make sure it fits the target storage. 

You’ll definitely need extra space if you 

do incremental backups, or decide to 

include directories like ~/Downloads 

that usually get populated with lots of 

large files.

Select what to backup

02 If you store a backup copy 

on the same drive with the 

original files, it can only save you from 

accidental deletion. It is therefore 

highly recommended to save backups 

to another physical drive or disk to 

protect yourself from main hard drive 

failure. For frequent incremental 

backups, external hard drives are 

known to work better compared 

to flash drives – the latter have a 

limited lifetime and don’t like too 

many overwrites. You can also use a 

remote destination via SSH, WebDAV 

or Windows shared folder. You can 

choose the right place via the Storage 

Location menu.

Choose a destination 

Set up your backup correctly with Déjà Dup
Get the settings right to secure your data

03If we had a crystal ball, we’d 

use it. But the fact is that 

nobody knows when things will 

go wrong. To protect yourself from 

experiencing that sinking feeling 

when you discover your backups are 

broken, go for a test restore at the very 

beginning. It’s a good idea to set up a 

small backup task and run it. After that, 

go to the Overview section and press 

the Restore button. Déjà Dup will 

guide you with a simple wizard, where 

you’ll be able to choose the location 

of a backup and then select a date, 

from which a copy will be derived. 

Go ahead with a real-world backup if 

everything restores fine.

Make a test restore  

“If we had a crystal ball, we’d use it. But the fact is that nobody 
knows when things will go wrong”

Fig 1 Choose to restore specific 
files individually
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04Déjà Dup has a limitation: 

it is an ‘all or nothing’ tool, 

meaning that you can’t extract 

selected files and directories. Instead 

you are forced to copy or download 

the entire backup snapshot. To solve 

this issue, use the ‘Restore missing files’ 

item in the Nautilus context menu (Fig 

1). This works for directories included 

in the backup and lets you restore 

individual files. Déjà Dup is a front-end 

to the Duplicity utility, and this lets 

you extract your backup snapshot 

without launching Déjà Dup at all. It 

can be useful for scripting, or maybe 

when you access your backup location 

remotely via SSH. The syntax for 

extracting is as follows:

  $ duplicity restore 
--no-encryption “file:///

  path/to/ snapshot” “/where/
to/extract” 

The Duplicity syntax also can extract 

individual backed up items (see $ 

duplicity --help).

Access a backup copy 

05The simplest way is to use 

your Dropbox, MEGASync or 

other cloud-synced directory as the 

backup location. This way, your data 

will be uploaded to the cloud once 

Déjà Dup finishes its job. However, let’s 

do direct online backups, such as to 

the Amazon S3 cloud (Fig 2). To make 

it happen, you only need a proper 

account at Amazon and a few extra 

packages. The command is as follows:

  $ sudo apt-get install 
python-boto python-

cloudfiles

After that, the list of available storage 

locations will be complemented by 

Amazon S3 and Rackspace cloud.

Back up to the cloud

“Déjà Dup has a 
limitation: it is an ‘all 
or nothing’ tool”

Fig 2 (below) Manage your backup 
location easily
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Use Startup Disk 
Creator
Create a bootable USB with Ubuntu                                       
or virtually any other Linux

The irst question that would most likely emerge 

here is ‘what on Earth would you need a startup 

disk for?’ Historically, Linux distributions were 

distributed as CD discs, from which you were 

supposed to install them. Later on, the age of 

recordable CD/DVD discs came in and, together 

with broadband Internet access, this led Linux 

enthusiasts to download ISO images of their 

favourite Linux distributions and burn them 

to blank discs. However, such optical discs are 

already out of trend, with USB thumb drives now 

being the sanest media. You can use USB sticks 

hundreds of times with strong reliability.

In Linux you can transfer an installable ISO 

ile to a USB drive by the ‘dd’ command. It’s 

quite easy, but the whole procedure isn’t very 

conclusive for regular users, so that’s why Ubuntu 

ofers the handy and convenient Startup Disk 

Creator utility. Its features slightly intersect with 

those found in Disks, but Startup Disk Creator 

focuses on turning CD/DVD discs or downloaded 

ISO iles of installable Ubuntu-compatible Linux 

distributions to bootable USB media, that is it 

helps you move from legacy media to more 

contemporary and eicient USB disks.

Startup Disk Creator also has the ability to 

use a newly created USB disk as a working 

environment in live mode, consequently saving 

all your data persistently on a disk.

Storage persistence 
A very useful feature that allows 
saving all your data persistently. 
This way you can turn your live 
Ubuntu thumb drive into a fully 
featured portable working system

Select the  disk to use 
Startup Disk Creator displays 
available target USB drives 
here. When you plug it in, 
the application detects it 
automatically and adds it to the list

Select the source
Here is the list of source disc 
images (.iso) and CD/DVD discs 
found on your system. Startup 
Disk Creator automatically updates 
the list
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Operating system version
Sometimes it’s not clear exactly which 
version of a system is inside an ISO, or 
what is on that unlabelled optical disc. 
The column entitled OS Version extracts 
necessary details

Choose an image file
If you want your ISO image to appear in the 
list, click the Other button and select the 
image file. By the way, it also supports disk 
images (.img)

Capacity and free space
You can find the total size of the media as 
well as the amount of free space on it. This 
feature is designed for USB sticks that are 
formatted to FAT16 or FAT32 file systems 
and may contain user data

Mind the size
The last column here indicates the size of the source media. 
It shows the exact weight of the ISO file, but defaults to 
the total capacity of CDs and DVDs no matter how many 
megabytes are actually there

Copy the files 
Check everything one more time and 
press the Make Startup Disk button. 
The application will show a progress 
dialog and copy the files onto the target 
USB medium

Get a live Ubuntu system  Use a regular USB lash drive or any mass-storage device
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Create a bootable USB stick  Utilise Startup Disk Creator

01Startup Disk Creator is designed 

to work with Ubuntu and other 

systems derived from it. Here is a short 

and incomplete list: Kubuntu, Linux 

Mint, Xubuntu, Lubuntu, Ultimate-

Edition, elementaryOS, Peppermint 

One, Peppermint Ice, Deepin and 

Zorin OS. Other flavours of Linux, 

especially those non-Debian based, 

might not work with Startup Disk 

Creator. If you have a free target USB 

medium, testing other Linux OSs and 

Select the proper source sharing the results will be welcome. 

If you have an Ubuntu-compatible 

system on CD or DVD, it will be a good 

idea to transfer it to USB and benefit 

from higher boot speed, better 

compatibility and persistent storage.

02 Common target devices are 

flash drive – also known as a 

USB stick or thumb drive – an external 

USB hard drive, an SD card or any other 

memory card connected through a 

Prepare the target 

USB card reader. Virtually everything 

that can be connected as a USB 

mass-storage device in Linux will work 

fine (Fig 1), including odd things like 

your smartphone’s internal storage. 

Startup Disk Creator doesn’t wipe any 

data from FAT32 volumes once there 

is enough space there for a source 

image. Although, it is recommended 

to use a clean flash drive or at least 

format it to avoid issues resulting 

from heavy use of that flash drive (for 

instance, a flash drive might suffer 

from fragmentation).

“It is recommended to use a clean lash drive or at least format 
it to avoid issues resulting from heavy use of that lash drive (for 
instance, a lash drive might sufer from fragmentation)”

Fig 1 Use Startup Disk Creator 
to create a USB startup disk
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03Drag the respective slider and 

define how much persistent 

storage you need for your files 

and settings. Startup Disk Creator 

will create a persistent storage file 

of an appropriate size and merge 

it with the root file system in the 

live system. Changes in the /home 

directory, downloads and other files 

added or removed from within the 

live system will be preserved after 

reboot. The same works for system-

wide components, for example you 

Create a persistence file 
can install extra software or remove 

something unnecessary and keep it 

after shutting down or rebooting the 

live OS. This makes your live USB stick a 

fully fledged portable OS. At the same 

time, the device will still be readable 

and accessible from Windows or other 

non-Linux OSs.

04When you are done with 

setting things up, and the file 

copying dialog finishes successfully 

(Fig 2), reboot and select your USB 

medium as a boot device. Startup 

Go for a test drive 

Disk Creator adds the Ubuntu 

bootloader to the FAT32 volume 

of your USB medium, so that it can 

boot Ubuntu. The experience doesn’t 

vary much between an OS written 

with Startup Disk Creator and with 

a classic live mode achieved with 

the ‘dd’ command. The only visible 

difference is that you can have 

persistent storage, even though it is 

limited with 4GB – this is a maximum 

file size in FAT32. You can write some 

files or folders on your USB medium 

in Windows (or elsewhere), then boot 

from it and find your files there, safe 

and intact.

Fig 2 Track install progress 
with this dialog box
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Unleash the 
Archive Manager
Make use of this small accessory that sits inside 
your Ubuntu system

Archive Manager is a small tool for opening compressed i les and 

creating your own archives. Years ago, when people had small hard 

drives, Archive Manager was king of the hill. It’s still an important 

part of the standard desktop experience, as it is the easiest way to 

unpack downloaded archives or combine many i les into one (Fig 1). 

The standard Ubuntu Archive Manager follows the generic 

naming policy and therefore doesn’t have any special name 

(together with Disks, Backups and so on). However, Ubuntu had 

taken it from the GNOME desktop, where the archive manager is 

called File Roller. You can check it out by launching the $ file-

roller command in the terminal in Ubuntu. When launched 

separately, the File Roller interface looks quite empty as because it is 

designed to show .contents in the largest area of its window.

Make use of extra features
File Roller has some extra features and boasts i ne integration with 

the Ubuntu i le manager, Nautilus. This means that you can extract 

any supported archive simply by right-clicking it and selecting 

Extract Here from the menu. You can also drag-and-drop i les and 

directories from Nautilus to the File Roller window in order to add 

them to an archive. The application will prompt you for an archive 

name and of er advanced options that include password protection 

(ZIP and CBZ only). You can protect just the i les and directories, so it 

will be possible to view the list of i les inside an archive, but in order 

to open or extract anything from such archive, one must provide a 

proper password (Fig 2). You can also protect the list of the archive’s 

i les and directories, or split an archive into parts of i xed size.

“It’s still an important part of the standard 
desktop experience”
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Open or view an archive
Opening an archive is simple: just double-click it or use the ‘Open 

with Archive Manager’ item in the right-click menu of an archive. If 

its icon looks like a box, it means that most probably such an archive 

will be supported. File Roller supports ZIP, RAR, GZIP, BZIP. 7Z, JAR, 

XZ and many other formats, for both opening and compressing, 

and also AR and ISO formats in read-only mode. You can also go the 

other way around: open the empty File Roller window and use its 

Open button to browse and select an archive. There is a dif erence 

between opening and viewing an archive. While it is clear what 

the i rst one means, the second lets you look through the entire 

list of i les and see the whole archive’s content in a single view. For 

instance, if there are many subdirectories in your archive, you may 

want to select View>View All Files and see everything as a single list. 

File Roller adds the extra Location column to help you see which i le 

is where.

The reason why you may need to 

create an archive can vary. Firstly, 

an archived file is always smaller 

than the original one, so the 

simplest goal is to save some disk 

space. This doesn’t help much 

with photos and videos, because 

they are already compressed 

and so adding them to an 

archive doesn’t save much space. 

However, office documents or 

uncompressed media files (DOC, 

XLS, WAV, TIFF and so on) show 

a splendid compression ratio, 

up to 90-95 per cent. Secondly, 

archiving merges many files 

into one archive, which is very 

convenient. For instance, copying 

a thousand of small files can 

take a long time (it drives most 

file systems crazy), but when 

compressed into an archive, 

you will wait for just a couple of 

seconds. To transfer files with 

symlinks and UNIX-specific 

attributes (like permissions and 

extra flags) to a FAT32 or NTFS 

volume, you should also archive 

such files first. Compress any file 

or directory using the Compress 

item in the right-click menu of 

an item, or use the respective 

feature inside File Roller.

Create an archive    

Fig 2 Protect files with a passwordFig 1 Compress files with the archive manager
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Use the Disk 
Usage Analyzer
Find out where your free disk space went with a    
specialised accessory

Files and directories tend to grow and occupy a large amount 

of disk space. These days even a couple of terabytes will run low 

when you decide to keep your movie collection there. Sometimes 

you don’t pay enough attention to how much you are actually 

downloading, copying or storing, meaning that your hard drive 

gets cluttered with lots of i les, draining your free space. Disk 

Usage Analyzer, also known as Baobab, is a tool that comes within 

a standard Ubuntu desktop. It analyses any directory you throw 

at it and shows a colourful ring chart, where the size of each slice 

corresponds to a size of the respective subdirectory (Fig 1). This is 

a beautiful graphical representation with instant usefulness, letting 

you know what on your drive is using the most space. Sometimes it 

can be as simple as an overi lled temporary directory, or a giant log 

i le, or just your media library that grew too fast.

Get instant results
Launch Disk Usage Analyzer by searching for this name or ‘Baobab’ 

in Ubuntu Dash. After it launches, you will be presented with a list 

of devices and locations. If a drive is mounted, it will be included in 

the statistics of your root partition. For example, if you mount a 4TB 

drive within a relatively small root partition (say, 20GB), the resulting 

ring chart will show your system directories within a hair-thin slice. 

For that reason, you will need to unmount any external media if you 

want to analyse what Ubuntu itself consists of. To get a structure 

of your home directory simply click its icon and wait while until 

Disk Usage Analyzer completes its job – this can take some time 

depending on how many i les there are.

“This is a beautiful graphical 
representation with instant usefulness”
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Dive into statistics 
There are no limitations with which directory you 

want to analyse. Disk Usage Analyzer lets you 

open any directory, be it a local or remote one. 

Click the small ‘gear’ icon in the top-right corner 

to open the desired location. If it is a remote one, 

please use the ‘Scan Remote Folder’ option and 

provide the correct address, for example Samba 

share addresses start with smb://. 

When you see the resulting ring chart, hover 

your mouse over a slice to see the details. Click 

a slice to dive in and set it as a top directory. The 

chart will adjust automatically and you will see 

more details about what content inputs to overall 

directory weight. The left part of the screen 

compliments the chart with a tree view, with 

extra columns for usage percentage, size and 

number of items.

Switch between graphical views 
This ring chart isn’t the only way you can get a 

graphical representation of data. In the lower right-

hand corner of the application you’ll notice two 

buttons that let you switch between ring chart 

and treemap modes. Treemap is an alternative 

method of data visualisation with a strong focus 

on the size of units. 

The main diference between a ring chart and a 

treemap is that the latter shows all units together 

along with subdirectories and large iles. This 

actually works better when you need to estimate 

the relative sizes of diferent units. A treemap 

may be hard to understand when you irst look 

at it, but it does help when you know how it’s 

built. Disk Usage Analyzer irst draws the largest 

rectangle for your top-level drive or directory 

and then recursively subdivides it into smaller 

rectangles according to the size of the content 

inside. Larger rectangles display their names 

instantly, others will give more information once 

hovered with a mouse.

Fig 1 (above) Your usage data is broken down 
visually with Disk Usage Analyzer
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Monitor 
Software & 
Updates
Add more application sources and keep your 
system up to date

Ubuntu comes with pre-installed applications and accessories for 

basic computing tasks and activities. Software & Updates lets you 

customise the standard set of software sources, coni gure updates 

and manage additional drivers. A software source is a general term 

that includes both online repositories and local media. You can turn 

standard Ubuntu software source on and of , manage third-party 

source and authenticate them with signing keys. With Nvidia or 

AMD graphics, you can install a proprietary driver, but it cannot be 

included in Ubuntu right away due to license restrictions.

Install additional drivers
A common case when Ubuntu users turn to the Additional Drivers 

tab in Software & Updates is graphics drivers. Computers with 

Nvidia and AMD video chips are supported in Ubuntu out of the 

box, but the system utilises open source drivers (‘nouveau’ and 

‘radeon’ respectively), that still lag behind a proprietary driver for 3D 

performance and gaming. To replace an open source driver with 

a proprietary one, go to the Additional Drivers tab and wait for a 

while before Ubuntu discovers if there is a proprietary driver for your 

hardware. It will not necessarily be a video card: dozens of drivers 

for wireless networks and various i rmware bits that improve system 

performance cannot be shipped directly because of their licenses.

When you decide to go with one or several non-free drivers, simply 

select them and press the Apply Changes button. Ubuntu will 

download all required i les in the background and install drivers 

automatically. You will then need to logout and log back in, or 

better, restart the system.
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Ubuntu periodically checks 

for its updates online and 

if it finds a newer version 

for at least one package, a 

special notification pops up. 

In the Software & Updates 

application, you can choose 

what updates the system 

looks for and how frequently 

checks should be carried out. 

To do this, go to the Updates 

tab and review the list of 

ticked boxes. By default, 

Ubuntu looks for security 

updates, recommended 

updates for regular packages 

and also for backported 

software that is not 

supported by Canonical, but 

contributes to the Ubuntu 

experience. The next four 

drop down menus control 

the updates frequency and 

behaviour. For instance, here 

you can program Software 

& Updates to download 

and install all or particular 

updates automatically, 

without disturbing the 

user. This can be helpful 

for unattended Ubuntu 

installation with a stable 

Internet connection. The last 

drop down menu lets you 

choose whether Ubuntu 

should notify about any 

new version of the OS itself 

or about long-term support 

version (LTS) only. If don’t like 

to hop to newer versions too 

often, stick to LTS releases.

Set up updates
Add or remove software sources
Standard Ubuntu repositories can be managed on the Ubuntu 

Software tab in Software & Updates. It lists the Main repository, for 

which Canonical (the Ubuntu maker) provides oicial support; the 

Universe repository, which is maintained by Ubuntu community; 

the Multiverse repository with proprietary software; and the 

Restricted one with closed-source device drivers. If you somehow 

need to develop software in Ubuntu yourself, you can enable the 

Source repository. Below are other helpful controls for selecting the 

nearest mirror (this can boost a package’s download speed) and 

the optional switch for Ubuntu CD/DVD with standard delivery 

of packages. The ‘Other software’ tab lets you add third-party 

repositories and by default lists entries within the Canonical Partners 

repository and the extra Independent repository for even more 

software (Fig 1). Press the ‘Add’ button to add a new repository, ‘Edit’ 

to change details and ‘Remove’ to delete a repository. There are 

many additional repositories on the Internet, but always approach 

with caution.

“Standard Ubuntu repositories can be 
managed on the Ubuntu Software tab”

Fig 1 Use Software & Updates 
to add third-party repositories
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Work with 
Universal Access
Coni gure accessibility settings to make Ubuntu 
more user friendly

Ubuntu is a friendly place for everyone, including people with 

reduced capabilities or disabilities. If you need to use special settings 

for a more comfortable user experience in Ubuntu, there is a 

dedicated subsection called Universal Access inside System Settings. 

If you want to, you can also launch it separately by searching its 

name in the Dash or by using the $ unity-control-center 

universal-access command in the terminal. Universal Access 

consists of a large number of settings divided into four individual 

categories: seeing, hearing, typing, and pointing and clicking. Each 

category has switches that improve usability and make the most 

out of Ubuntu. Ubuntu ships with a high-contrast icon theme and 

the Large Text switcher, both of which help visually impaired people 

see more on their screens. There is also a screen reader (Fig 1), which 

pronounces window titles and messages, an on-screen keyboard, 

advanced sound notii cations and more.

Using the keyboard as a cursor
If moving a mouse in a regular manner is uncomfortable, you can 

control the mouse cursor from a keyboard using the arrows. This 

accessibility feature can be enabled by going to the Pointing & 

Clicking tab and putting the Mouse Clicks switcher on. There are 

also two ways to trigger a mouse click without clicking its buttons. 

The i rst tweak is to simulate secondary click in double-clicking by 

holding the left mouse button down for some time. Second, you 

can simulate a click by hovering a mouse cursor over an item and 

waiting longer. For either, there are helpful sliders that let us adjust a 

delay. Regular mouse settings in the Mouse & Touchpad subsection 

also contribute to a more l exible mouse performance. There you 

can lower the double-click delay, change cursor speed and switch 

buttons arrangement if you need a mouse for left-handed use.

The Typing tab in Universal 

Access houses a list of options 

that help input data using 

a keyboard for those who 

are unable to type and need 

assistance (Fig 2). The most 

noticeable option here is the 

on-screen keyboard switch 

that enables text input using 

mouse clicks. The on-screen 

keyboard will appear after 

you re-log in to a session. It 

looks like a desktop widget 

that flows at the top of any 

windows. There are various 

keyboard tweaks that can 

ease input in some cases, 

such as sticky keys (treats a 

sequence of modifier keys as 

a key combination), slow keys 

(puts a delay between when 

a key is pressed and when it 

is accepted) and bounce keys 

(ignores double pressing a 

key in a short period). This 

can be complemented with 

extra audible notifications, 

such as beeping when 

certain keys are pressed. 

The on-screen keyboard in 

Ubuntu can also be used 

for extra security if you feel 

like the use of a physical 

keyboard can compromise 

your privacy.

Type the way you 
need to
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“If you need 
to use special 
settings for a 
more comfortable 
user experience 
in Ubuntu, there 
is a dedicated 
subsection called 
Universal Access”

Adopting Orca screen reader
The default screen reader in Ubuntu is called Orca. It can be enabled in the Seeing tab of Universal 

Access, or it can also be launched from command line ($ orca). Orca pronounces titles and text 

corresponding to the controls in use. To access Orca preferences after enabling it for the irst time, press 

‘Ins + Space’ on a desktop keyboard or ‘Caps lock + Space’ on a laptop. A new window will open, and 

Orca will announce “Screen reader preferences. General page tab.” You can now conigure Orca to your 

liking, change voice type and speed, redeine key bindings, turn Braille support on or of and change 

lots of other tunables. Orca also lets you customise its verbosity and deine the categories of text that 

will be spoken. It also has a built-in help system in audible mode. Press ‘Ins + H’ or ‘Capslock + H’ to hear 

instructions and references to other important key bindings.

Fig 2 (above) Customise your computing experience with typing options

Fig 1 Tweak screen settings for 
better usability
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Configure 
network 
connections
Setting up a network connection in Ubuntu is easy

Those who only need to plug their Ethernet cable into their 

computer’s network port in order to have an instant access to 

the Internet can skip this section (perhaps those running Ubuntu 

inside a virtual environment can do that too). The majority of 

Linux newbies, however, often need assistance in connecting 

to the Internet or changing their network parameters. During 

the last decade, almost every Linux distribution has relied on 

NetworkManager – a stable, feature-rich and intuitive network 

handler for Linux. The Unity desktop in Ubuntu has a tight 

integration with NetworkManager by of ering a network indicator 

on the top bar and a standalone graphical utility called Network (Fig 

1). You can search for it in Dash, open it as a subsection in System 

Settings or launch from command line ($ unity-control-center 

network). Both wired and wireless network connections can be 

added and modii ed or even removed here.

Fig 1 (right) Configure wired and non-
wired network connections
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Connect to a wireless or wired network
If you want to use a wireless connection and if you have a Wi-Fi 

network card or chip, things are quite easy: notice the ‘radar’ sign 

at the far-right position on Unity top bar and click it to see a list of 

available networks. Select your network and once you provide the 

correct authentication password, you are mostly done. With wired 

network connection, for which you are given an IP address, network 

mask and a gateway address, you’ll need to enter the Network 

coniguration dialogue and add your connection manually. To do 

so, irst check that the global switch for wired networks is in the On 

mode and then press the ‘Options’ button in the lower-right corner 

of the window. This will bring up the connection editor (Fig 2), in 

which the most common place to go is the IPv4 Settings tab. In the 

Method drop-down menu, select Manual and then provide your 

connection details in ields below.

View connection settings
When you are 

online, you still 

may want to use 

NetworkManager 

to ind out certain 

details about your 

current connection. 

The quickest way to ind out such details will be to click on the 

network indicator on the Unity top bar and go to the Connection 

Information item. You will see a separate window with lots of 

details about your connection, including general settings (your 

network car MAC address, declared speed, interface name), and IP 

connection details for both IPv4 and IPv6 (if it is relevant for you). 

The main window of the Network application also displays network 

settings and includes a briefer list with Hardware Address (MAC), 

IP Address, Default Route and the list of DNS servers. If you cannot 

run NetworkManager in graphical mode for some reason, use the 

‘$ ifconfig’ command to view settings and ‘$ nmcli’ to manage 

various connections. For instance, let us bring up a known Wi-Fi 

connection from within a broken Ubuntu system that cannot boot 

into any desktop:

  $ nmcli dev wifi con “Network_Name” password “your_password”

Sitting behind a proxy adds 

a little complexity. Usually 

you have to declare your 

proxy settings several times: 

separately for a web browser, 

in the Bash environment, for 

Apt package manager, for 

Wget downloader and so 

on. However, Ubuntu makes 

things a little easier on this 

front. Click the ‘Network 

Proxy’ item in the list on the 

left and choose what kind 

of proxy setup works for 

you. If you have been given 

a URL, select the Automatic 

method and provide that 

URL in the field below. Proxy 

with personal authentication 

usually requires manual 

setup. Select the Manual 

method and provide at least 

the HTTP proxy, using the 

following syntax:

  username:password@
server-name.domain

Provide a proper port and 

finally hit the ‘Apply system 

wide’ button to finish with 

setup and get going. 

Set up a 
network proxy

Fig 2 Input details 
manually using the 

connection editor



Ubuntu essentials

84

Connect with Online Accounts

Connect with    
Online Accounts
Enjoy a more convenient integration with online services in Ubuntu

Online social services are already a part of everyday life for an average user. Most of us use these services 

for connecting with friends and relatives, for sharing photos, videos and other iles. Almost every online 

service requires authentication, which is commonly about registering an account and using it later for 

accessing the personal part of a service. Ubuntu simpliies the general experience with online services 

by eliminating the need to sign into one account several times in diferent applications. It also makes 

using local applications easier because it is much more convenient to provide your username and 

password on a classic login web page than to have the hassle of local application settings. A good 

example is the Evolution email client. Years ago people had to remember incoming and outgoing 

server addresses, ports, security settings and the authentication method. Now all you have to do is 

provide your username and password for your email service in Ubuntu’s Online Accounts – when you 

log in there Evolution will already be conigured and automatically display your inbox.

Set up instant messaging
Empathy is the default app 

for instant messaging. Open 

Online Accounts (Fig 1) either 

by searching for it in Dash 

or as a subsection in System 

Settings. You can even go 

from the command line 

($ unity-control-center 

credentials). The list of online 

services, for which Ubuntu 

ofers desktop integration, 

has grown recently so you 

may want to ilter the list by 

applications. In the ‘Show 

accounts that integrate with’ 

drop-down menu select 

Empathy. Select the desired 

service and provide credentials Fig 1 (above) Connect to your accounts quickly using Online Accounts
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Connect to your Google account
Online Accounts ofers the most comprehensive integration with 

Google services. If you have a Google account (using Gmail for 

example), you can beneit from a wide list of desktop applications 

that Ubuntu can integrate with. It includes Evolution Data Server, 

Shotwell photo manager, Google Drive and Picasa lenses for Unity 

Dash and Empathy instant messaging.

Once you’ve logged in to your Google account it will prompt 

you to allow it access to manage your emails, calendar, photos and 

videos, contacts, view your data and so on. You have to grant this 

access in order to proceed. After that your list of connected services 

will be populated with everything Ubuntu supports for Google 

and you can start using your favourite applications and enjoy 

them working without your Google account without any extra 

movements. Your search results can now include iles found on your 

Google Drive and Picasa web albums. You can also start using Gmail 

directly from your Evolution client and do much more.

“Ubuntu simpliies the general experience with online services 
by eliminating the need to sign into one account several times”

in a built-in browser window, right there in Online 

Accounts. You can even add more than one 

account of the same service, or add accounts 

from various diferent services to one application. 

Online Accounts lets you enable, disable and 

change options of added entries at any time. After 

you are done, you can launch Empathy and start 

chatting immediately.

Ubuntu ships with Shotwell, 

a photo manager, viewer 

and simple editor. Not only 

can you sort and tag images, 

but also import them from 

external sources and export 

to a cloud account – the latter 

requires integration with 

Online Accounts. Shotwell 

can publish your photos to 

Facebook, Flickr, Picasa Web 

Albums and Piwigo CMS. You 

can configure one of these, 

all, or any combination of 

services by adding respective 

entries in Online Accounts. As 

with Google, in most cases 

you are required to pass an 

authentication routine and 

grant access to your data  

(Fig 2). After that you can 

launch Shotwell and select 

one or several photos you’d 

like to publish. Notice the 

toolbar along the bottom of 

the window and press the 

Publish button there. Select 

a cloud service from the 

drop-down list and choose 

publishing options. Shotwell 

can create new albums in an 

account or commit to existing 

ones. It also supports tags 

and photo metadata in its 

publishing module.

Upload photos  
to a cloud-based 
account

Fig 2 (above) Input your password and connect
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Use System 
Monitor
View and manage system resources using   
the System Monitor app

System Monitor is a tool for managing running processes and 

monitoring system resources. It is one of many accessories 

borrowed from the Gnome desktop. You can run from Dash or 

from command line ($ gnome-system-monitor). The application 

looks and works similarly to its analogues in Windows and OS X, and 

contains three logical tabs: Processes, Resources and File systems. 

Launch the application with a specii c tab showing by using 

command line parameters ‘-p’ for processes, ‘-r’ for resources and 

‘-f’ for i le systems. Launching with the File Systems tab shown can 

be done with the ‘$ gnome-system-monitor -f’ command line. 

System Monitor is used to tackle system sluggishness. You could 

also use the CPU load graph to i nd out if hardware-accelerated 

video output really works.

Manage system processes
Each application in Linux creates at least one process. Some 

processes refer to graphical applications, others run in the 

background and provide service functionality. With the help of 

System Monitor you can view the list of all processes, know their 

names, i nd out which process belongs to which users, detect 

processes that devour too much CPU cycles or draw high levels 

of RAM, associate processes with their low-level IDs and manage 

process priority. Normally you’ll see a list of processes sorted 

by name. Note that you can click the name of a column to sort 

processes by it. It is very helpful to sort them by CPU percentage 

or memory usage. If a process belongs to you (or if you have the 

permissions), you can kill it or lower its priority. Select the process 

you want to get rid of and press the End Process button in the 

lower right corner of the window. Right-click the process and select 

the Change Priority menu to alter its priority. 

The File Systems tab displays 

a table of all file systems that 

are currently mounted in 

Ubuntu. You can find out the 

device name, file system type, 

mount point, total capacity 

and available disk space. Of 

course, you can find out a 

similar set of information in 

Ubuntu’s disk utility (Disks, 

p.50), but System Monitor 

offers a more comfortable 

view, which lets you quickly 

analyse how much space is 

left on your device and sort 

them by various criteria. 

The Used column doubles 

the information about free 

disk space, but shows it in 

the form of a percentage 

bar. When the bar fills up 

to approximately 90 per 

cent or more, it means that 

you are running low on 

free disk space, which can 

be troublesome for certain 

workflow scenarios. Ubuntu 

cannot work properly if the 

root partition (/) gets 100 per 

cent full. You can also check 

for free disk space in terminal 

by using the ‘$ df’ command 

(disk free), although it doesn’t 

let you sort or reorder any of 

the lines.

Find out details 
about file systems
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Control resources usage
The Resources tab ofers efective graphs that get 

updated in real time (Fig 1). The irst graph shows 

CPU History in live mode (there is no delay in data 

update by default), showing CPU cores in diferent 

colours. When you launch a heavyweight 

application you’ll notice peaks on that graph. 

You can also igure out whether an application 

can use several CPU cores at once, or if pushes 

all of the load on one core. The middle graph 

is for Memory and Swap Usage. On modern 

systems, swapping to a ile or to a separate Swap 

partition is rarely used in everyday tasks, simply 

because there is already suicient RAM. However, 

processing large iles (like retouching a giant 

poster in GIMP) may require swapping, which only 

takes place when your system is running low on 

available RAM. The inal graph, Network History, 

shows the network speeds for both downloading 

and uploading. This graph can be particularly 

helpful for network troubleshooting and low 

Internet speed diagnostics. Both memory and 

network history graphs help you monitor your 

system’s performance.

Fig 1 Graphs help visualise performance data
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Explore  
the Ubuntu 
Software Centre
Navigate your one-stop shop for purchasing, 
installing and removing apps

Ubuntu Software Centre, aka USC, is a package management portal 

– that is, a consolidated platform where you can search for, install or 

purchase software, and even remove apps from the list of installed 

software. Initially released on 29 October 2009, Ubuntu Software 

Centre is developed in Python and contains more than 53,000 apps. 

Previously, Ubuntu programs were downloaded from the repository 

as tar i les, unzipped and then installed, by manually running the 

commands in the console. Even the previous versions of Ubuntu 

had many graphical utilities for adding/removing software, which 

Fig 1 Sub-sections for All Software and 
Installed help you navigate
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“Initially released on 29 October 2009, Ubuntu Software Centre 
is developed in Python and contains more than 53,000 apps”

ultimately led to redundancy and fragmented 

development efort. To ease this cumbersome 

process, USC came with a worthwhile approach 

where all the software is installed with the click 

of a few buttons. The search for speciic software 

ends here as USC has name/description-based 

search functionality, with multiple options to 

choose from. The rating and users’ review helps 

you to ind the best software. USC also provides 

Ubuntu application developers a prominent way 

to ofer their software to potential users. 

The latest version of Ubuntu comes with 

some preconigured tools and software like the 

LibreOice suite, Mozilla Firefox, text editors, 

Software Centre etc, which are displayed vertically 

in the left sidebar. To get started, search for the 

shopping bag icon in the display and click it to 

launch Ubuntu Software Centre. 

Upon the launch of USC, the home screen 

appears, which contains diferent categories of 

software, recommended software, newly added 

software (Fig 2), top rated software and many 

more. For instance, if you’re looking for a text 

editor, you can type the keyword in the search 

bar, which shows the diferent text editors present 

in USC in a list view. You can just select any 

one of them and click the Install button to start 

download the program.

Fig 2 The Software Centre is arranged into 
categories to help you find what you need
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On the top of the home screen you will ind the 

section navigation commands: All Software and 

Installed (Fig 1, page 88). The Back and Forward 

buttons – displayed as ‘<’ and ‘>’ respectively – 

help you navigate the diferent pages. USC keeps 

the visited pages in memory so that by clicking 

the Back button once, you’ll reach the page 

you just left. The Back command is unavailable 

whenever no previous screens exist in the history, 

and the Forward command whenever no later 

screens exist in the history. The All Software 

section presents all the programs available, be 

“In the Installed section you will ind the list of programs that 
are installed on your Ubuntu machine”

Get to know Software Centre  Start installing the software you need

Fig 3 Register with Ubuntu to 
make recommendations
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In terms of display, if the 

category is set to ‘Show non-

applications by default’, then 

results are displayed in a list 

view; otherwise tile view is 

used, and non-application 

items are hidden by default. 

The top rated applications 

are also displayed on the 

home screen using tile view 

in descending order of DR 

(dampened rating), regardless 

of whether they are installed 

or not. Applications with 

seven five-star ratings and 

one four-star will be displayed 

before other applications 

having two five-star ratings. 

12 items are displayed in the 

home screen under the Top 

Rated tab; when the More 

button is clicked, you land on 

a page where 60 items are 

displayed in decreasing order 

of DR using the list view.

Top Rated

Navigate via categories  The various ways to navigate the Software Centre

they already installed on the computer or not. 

In the Installed section you will ind the list of 

programs that are installed on your Ubuntu 

machine, with the date of installation speciied. 

When a software item is selected, if the item is 

not currently installed in your system, you will see 

an Install button. Click to install the software on 

your machine. If the software is already installed, a 

Remove button is available; clicking it will uninstall 

the software. 

On the home screen itself, you will ind the 

section ‘Recommended For You’. In order to make 

use of the recommendation facility, you have 

to register yourself in Ubuntu by providing the 

details in the form with a valid email ID (Fig 3). 

You will receive the veriication code at the email 

address provided (Fig 4). Once that process is 

complete, you will receive a success message and 

Ubuntu starts recommending useful software 

to you, which you can select and install on your 

machine with ease.

The USC segregates software into diferent categories, such 

as accessories, developer tools, books and magazines, games, 

education, oice and many more. Upon clicking the Accessories 

tab, for instance, a list of accessories is displayed, including Speed 

Crunch (precision calculator), 7zip (compression/uncompression 

tool), PuTTY (SSH/Telnet client) and Shutter (screenshot utility). The 

software listed in the Accessories tab is by default sorted by rating; 

the other sorting criteria are name and release date. 

“The software listed in the Accessories 
tab is by default sorted by rating”

Moving on to the Developer Tools page, you will ind many 

open source tools which are subcategorised into version control, 

IDEs (integrated development environments), web development 

and so on. The version control subcategory has many lavours of 

versioning software, prominent ones being Git-Cola, qgit and ggit. 

The IDEs tab has Netbeans, Ninja, Spyder and Eclipse, which can be 

installed and used for software development. There are also other 

subcategories named after software languages – like Java, Python 

and Perl – that contain the diferent versions and tools related to the 

speciic language.

Fig 4 (above) A verification email will confirm the process
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On the home screen of USC you will ind the 

History tab; when clicked, this shows the ‘All 

Changes’ page by default. Under the navigation 

bar are tabs for All Changes, Installations, Updates 

and Removals (Fig 5). The entries are grouped 

in branches and labelled by the day in reverse 

chronological order; (newest on top). Clicking 

anywhere on a branch (or pressing the space-

bar when it is selected) should expand it if it is 

collapsed, and collapse it if it is expanded. 

The branch on which the recent activity has 

occurred is opened by default in the USC history 

Updates and past downloads  Check out the History tabs

Fig 5 The History tabs reveal past updates
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“The Software Centre contains a list of 
programs provided by Ubuntu itself”

As well as offering a vast 

selection of free software 

to download, the Ubuntu 

Software Centre provides 

the option to purchase and 

install commercial software. 

The Software Centre contains 

a list of programs which are 

provided by Ubuntu itself, 

along with software offered 

by Canonical’s partners 

(those programs which 

abide by the software rules 

of Ubuntu). The number of 

programs available in the 

Software Centre continues to 

grow rapidly, so there’s a lot 

of choice. In simple terms, the 

Ubuntu Software Centre is 

the equivalent of the Google 

Play Store (or Apple App 

Store) for Ubuntu, where 

you can find thousands 

of programs, tools and 

applications which can be 

installed with just a few clicks. 

One-stop shop   
for Ubuntu

screen. The items displayed in the History tab contain the icon of 

the software, name, plus the date and time of installation. Under the 

Installation tab, you will ind all the installed applications grouped 

by their installation dates. The Updates tab, on the other hand, lists 

all the updated applications along with their update dates. Finally, 

the Removal tab displays the list of applications which have been 

uninstalled from the system. 

In the History tab, the search bar present on the top right can 

search for applications which are already installed or have been 

removed from the system. Whenever the Back ports channel 

contains a version of any application which is newer than the 

one installed, an Updates item appears in the last navigation bar. 

The Updates section displays the number of application updates 

available, along with an Update All button. The list contains the icon, 

title, the newer version of the application and an Update button at 

the far right end. 

When an item is selected, pressing the Enter key should activate 

its Update button; when an update is installed or waiting to be 

installed, its Update button should be inactive.

Installing programs  Get your hands on brand new programs

Now we’ve covered navigation 

and layout, let’s move on to 

installation. In this example, 

we’ll install OpenJDK Java 7 

and the Eclipse IDE. Select 

the Developer Tools category 

from the home screen of 

USC. This will take you to the 

Developer Tools page, which 

is further subcategorised. Click 

on Java (cup of cofee icon), 

which takes you to the page 

where Java-related items are 
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displayed in a list view (Fig 6). Now select the item 

Open JDK Java 7 Runtime and on the right side 

you will ind the Install button; click it to install 

the packages. You’ll then be prompted to enter 

your administrator password; type the correct 

password and hit Enter to start the installation. 

During installation, you will ind the progress icon 

graphically displaying the status of the installation. 

Once it’s complete, you will be redirected to the 

success page, which also contains the Remove 

button in order to uninstall the program. 

Click the Back button to search for the IDEs 

section; now click the IDEs icon to see the list of 

IDEs present in USC. Type ‘Eclipse’ in the search 

“There are many programs to install, such as chat apps, ile 
sharing and more”

Fig 6 Java install options are listed on this page
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bar to search for the Eclipse IDE. Select the Eclipse 

IDE (blue ball icon) and then click the Install 

button; enter the administrator password to start 

installation. Once Eclipse has successfully installed, 

open it by double-clicking. 

Create a project named ‘Hello’, with a Java 

ilename of Hello.java, in the test package. Now 

run this program to get an output in the console. 

This conirms that both Java and Eclipse are up 

and running.

Advanced software suggestions
Look at some of the advanced tools available in the Ubuntu Software    

Centre and see how they can help you in your activities

Switching from Developer Tools to Internet in the category section of USC, you will ind many program 

to install, such as chat applications, ile sharing tools, email clients and web browsers. By clicking the File 

Sharing tab, you will see many tools, FileZilla being the highest rated one (Fig 7). FileZilla uses FTP, SFTP 

and FTPS mechanisms to share and upload iles to diferent systems. Just click on the Install button and 

start sharing your iles within diferent systems.

In order to use your Ubuntu computer for oice work and view diferent formats of iles, you will ind 

the Kile application under the Oice category. The source editor is a multi-document editor designed 

for .tex and .bib iles. Menus, wizards and auto-completion are provided to assist with tag insertion and 

code generation.

Fig 7 FileZilla is the highest rated program
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Browse the 
Internet with 
Firefox

Internet browsing is one of the most common activities of 

the average computer user. People use the Internet for almost 

everything, from online shopping and reading to gaming and more. 

Almost all Internet access is via an Internet browser, and a signii cant 

amount of time spent on a computer is often on a browser. So 

it is very important that you understand your Internet’s interface 

extremely well. 

Ubuntu ships with Mozilla Firefox as a default browser. You’ll i nd 

the browser icon on the left bar on the Ubuntu Home page. When 

you launch Firefox, you will see the Google search page as the 

Home page. Note that the default search engine is Google, but you 

are able to change it to other search engines, such as Yahoo!, Bing 

or DuckDuckGo, for example. To change the default Home page, go 

to Menu>Preferences>Home page and enter the URL you would 

like to set as the Home page (Fig 1, page 98). 

You can also drag and drop an open tab on to the Home icon 

on the right icon bar. This will automatically set the Home page. To 

bookmark a web page, click on the star icon of the right icon bar 

while the page is open. The address bar automatically shows a list of 

pages from your browsing history and bookmarks when you start 

typing in the address bar. 

One of Ubuntu’s default browsers, explore the 
hidden features of Mozilla Firefox

“Ubuntu ships with Mozilla Firefox as a 
default browser. You’ll i nd the browser 
icon on the left bar on the Ubuntu Home”
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Address and search bar
Enter the website address here to 
browse the Internet. The address bar 
is smart, as it automatically suggests 
websites based on your history and 
bookmarks. You can enter search 
queries in the search bar

Icon bar
This bar holds icons for other services 
like Pockets (to save reading lists), 
Downloads, Home and Chat. The last 
icon opens up the Settings menu

Add and view  
bookmarks
You can add a bookmark with 
the star icon and view all the 
saved bookmarks by clicking on 
the next icon

General options
This area holds all the major 
options that Firefox has to offer. 
You can open new windows, 
print, view history, edit settings 
and more

Customise
You can configure the button 
positions, themes and overall look 
and feel of your Firefox installation 
using the Customize option here

Sync
This is where you can log in to 
enable syncing of your browsing 
data across all your devices

“The address bar automatically shows a list of pages from your 
browsing history and bookmarks when you start typing in the 
address bar”

Discover Firefox  Learn various Firefox settings to speed up your browsing

Zoom
Click on the ‘-’ sign to zoom out or 
the ‘+’ sign to zoom in to the web 
page. The middle area here shows the 
current zoom percentage

Editing  
buttons
You can edit website URLs or 
text that you enter in websites 
using this buttons
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Improve your browsing experience
Important aspects of web browsing with Firefox

01There are steps that you will 

repeat several times a day 

without realising how much time they 

take, for example, searching specific 

websites. Instead of going to the 

search engine, finding the search box, 

entering the keyword and executing 

the search, you can directly search the 

Internet using Firefox, while you are on 

any website. 

To set this up on your browser, 

visit the page on the target website 

that has the search field you would 

normally use to search the site. Hold 

down the Ctrl key and click on the 

Search website from the 

address bar

search field. Select ‘Add a Keyword’ 

for this search. The ‘Add Bookmark’ 

dialog appears. Enter an appropriate 

name for the bookmark (for example: 

‘Wikipedia search’). Create a keyword 

(like ‘wikipedia’). Select the bookmark 

folder to contain the smart keyword. 

Click OK. To use the created smart 

bookmark, enter the keyword and 

search string in the Location bar then 

press Return.

02 People now use multiple 

devices to access the Internet. 

Firefox helps to make sure all your 

Sync information across 

devices

bookmarks, links and other things 

are synced across devices seamlessly. 

Firefox does this with a feature called 

Sync. It lets you share your data and 

preferences (such as your bookmarks, 

history, passwords, open tabs, Reading 

List and installed add-ons) across all 

your devices. 

Let us see how to set up and sync 

an account in Firefox. First, click on 

the menu button and click ‘Sign in to 

Sync’. The sign-in page will open in a 

new tab. Click the ‘Get Started’ button. 

Fill out the form to create an account 

and click ‘Next’. Take note of the email 

address and password you used; you’ll 

need it later to log in. Check your 

emails for the verification link and click 

on it to confirm your email address. 

Browse the Internet with Firefox

Fig 1 (above) It takes a few simple steps to change our default home page
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“Private Browsing allows you to browse the Internet without 
saving any information about which sites and pages you’ve 
previously visited”

You’re ready to go! Now you just need 
to log in to Sync on all your other 
devices and let it do the rest. 

Technet24.ir

03As you browse the web, Firefox 

remembers lots of information, 

for example the sites you’ve visited 

and your passwords. There may be 

times, however, when you don’t want 

people with access to your computer 

to see this information. Private 

Browsing allows you to browse 

the Internet without saving any 

information about which sites and 

Protect your privacy 

while browsing

pages you’ve previously visited. Private 

Browsing also includes Tracking 

Protection, which prevents companies 

from tracking your browsing history 

across multiple sites. To open a private 

browsing session, click on the menu 

button and then click ‘New Private 

Window’. If you want to directly 

open a link in a new private window, 

hold down the Ctrl key while you 

click on this link and choose the 

option to ‘Open Link in New Private 

Window’ from the context menu.

04Mozilla offers the browser 

platform to developers as well. 

Install an app

This paves the way for thousands of 

interesting and useful apps in the 

Mozilla marketplace (Fig 2). With a 

wide selection of games, music and 

productivity apps, Firefox Marketplace 

has something for everybody. To 

install an app, open Firefox, click on 

the ‘Tools’ menu and select ‘Apps’. This 

will open up the marketplace. Now, 

type a search query in the search box 

to look for a specific app or choose 

a category for the type of app you 

are looking for. You can also choose 

the screen type from the drop-down 

menu to see apps optimised for that 

screen size. Click on an app to view its 

details. Finally, if you’re ready to install 

an app, click the blue install button. 

Browse the Internet with Firefox

Fig 2 (above) Go to the Mozilla marketplace to download apps
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Manage your 
emails with 
Thunderbird

Part of the Mozilla suite, Thunderbird is a lightweight mail client. It 

supports dif erent account protocols like POP, IMAP, Gmail etc. It also 

has an integrated learning spam i lter that of ers easy organisation 

of mails with tagging and virtual folders. More features can be 

added by simply installing extensions. If you’re an avid reader, 

Thunderbird acts as news and RSS client as well. So you can get all 

your information at a single point of contact. 

Tabbed email lets you load messages in separate tabs so you can 

quickly jump between conversations. A quick i lter toolbar helps 

you i lter messages by tags, contacts, keywords etc. Other features 

include message archiving, customisable themes and personas, 

smart folders, and even chat integration. You can also add social 

media accounts, like Twitter and Facebook, directly to Thunderbird 

and chat with your contacts with accounts on these platforms. 

Thunderbird is installed by default on Ubuntu 16.04, so just i re 

up Dash and search for it. Click on the icon in the results to launch 

Thunderbird. You can now add your email accounts to get started 

here. Note that Thunderbird, in association with some service 

providers, of ers email servers as well. So, you can avail a new email 

ID right from the Thunderbird GUI. If you don’t want a new email 

address, however, just select ‘Skip this and use my existing email’. 

Work remotely and learn to manage all your 
email accounts using Thunderbird

“You can also add social media 
accounts, like Twitter and Facebook, 
directly to Thunderbird”
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Get messages
You can use this 
button to force sync 
with the email servers 
and fetch all the new 
messages for all your 
email accounts

Search and filter
You can search your mailbox 
for specific keywords or filter 
the mail based on sender, 
recipient, subject etc from 
this section

Write
Click here to open the 
Mail Compose dialog 
and write a message

Explore Thunderbird  Discover key features of the Thunderbird UI

Address book
This holds all your contact 
details from different mailbox 
accounts in a single place

Mail folder list
This section holds all 
the mail folders from 
all your mailboxes. If 
you have enabled the 
unified mailbox, you’ll 
see each mailbox as a 
child inside the generic 
mail folders

Mail list
This is the section that 
shows a list of all your mail 
in a chronological order. 
Just click on the column 
header to sort them based 
on different criteria

Chat
All the social platform 
profiles such as Facebook, 
Twitter etc (if linked to 
Thunderbird) are visible 
inside this chat box

Mail display
This section displays 
a detailed view of the 
mail selected in the 
pane above. You’ll see 
the reply, forward and 
delete buttons here



Ubuntu apps Manage your emails with Thunderbird

102

To add chat accounts to 

Thunderbird, click on 

the Chat button next 

to the Email button on 

Thunderbird’s launch page. 

After you click the link, you’ll 

see a pop-up with supported 

services. Facebook, Twitter, 

Google Talk, IRC and Yahoo 

are all supported. Select 

the account to add and 

click Next. On the next 

page, enter the username 

and then on the next page, 

select the alias. Finally, 

click the Finish button. 

You will then be taken to 

the website of the account 

you chose to authenticate 

access to your account. Once 

authenticated, you can view 

all your social conversations 

in a new tab. Another aspect 

of Thunderbird chat is that 

all the chat conversations 

are included in search. 

So, if you are looking for a 

keyword, just type it and the 

results you get will include 

results from your past chat 

conversation history.

Social chat with 
Thunderbird

Use Thunderbird as your mail client
Setting up a new account with Thunderbird is easy. Start by clicking 

on the ‘Email’ link on its launch page. You then need to provide your 

username and password for your email provider and your email 

address (Fig 1). Thunderbird determines connection details (such as 

ports, server names, security protocols, etc) by looking up your email 

provider and can usually provide the account details. 

You need to conigure your account manually if your email 

provider is not listed in Thunderbird’s database, or if you have a non-

standard email coniguration. To conigure an account manually, 

you need the following details: incoming mail server and port (eg 

‘pop.example.com’ and port 110), outgoing mail server and port (eg 

‘smtp.example.com’ and port 25), and the security setting for the 

connection with the server (eg ‘SSL/TLS’ and whether or not to use 

secure authentication). Fill in these details and you are good to go. 

“Setting up a new account with 
Thunderbird is easy. Start by clicking on 
the ‘Email’ link on its launch page”

Fig 1 (above) Input your name, address and password 
details to link a new account
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Unified folders is a folder 

pane view which resembles 

a global inbox account: 

it merges the contents 

of all inbox folders (both 

POP, IMAP and local folders) 

from all accounts. It also 

shows the inbox of each 

account as a child folder of 

the unified Inbox account. 

Any message in an inbox 

shows up in both the root of 

the unified Inbox, plus the 

child folder of the unified 

Inbox. Each account displays 

any child folders of the 

inbox, only its inbox folder 

has been ‘moved’ away 

from the account. This does 

not change where and how 

messages are stored. Unified 

is just another way to view 

your folders at a single point. 

To enable unified folders, go 

to View> Folders>Unified 

Folders and select it. 

Alternately, if you don’t want 

to use the feature, use View> 

Folders>All Folders to select 

a more traditional display. 

Multiple mail 
accounts with 
unified folders

Extend Thunderbird features
Thunderbird has an open, extensible design and program 

architecture. This enables people to create add-ons for it. Most of 

these are distributed via the Mozilla add-ons site, but authors can do 

so any way they choose. Let’s see how to install an add-on… 

To start, go to Tools>Add-ons. Click on Get Add-ons (Fig 2). Type 

the name or keywords of the add-on you want in the search ield 

and click the magniier icon. Then select the add-on from the list 

and click ‘Add to Thunderbird’.

Click on Install Now once the button is available. Note that the 

add-ons from the oicial site (addons.mozilla.org) are reviewed by 

Mozilla and are relatively safe to install. Also, if the author is veriied, 

the author name will be displayed. Finally, restart Thunderbird to 

complete your changes.

To remove an add-on, go to Tools>Add-ons and select the add-

on to be removed from the Extensions, Themes or Plugins panel. 

Then click Disable to prevent it from loading; you can also click 

Uninstall to completely remove it. 

“Thunderbird has an open, extensible 
design and program architecture”

Fig 2 (above) Head to the Mozilla add-ons site to 
improve your Thunderbird features
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Communicate 
with Empathy

Instant messaging, also abbreviated to IM, is a text-based means 

to communicate instantly over the Internet and the local network. 

While some IM applications need you to create a new account, 

others provide IM facilities by using accounts from dif erent service 

providers like Google, Yahoo, etc. IM applications can also be used 

to connect to chat rooms. For the uninitiated, chat rooms are online 

places where like-minded people meet to talk. 

In this feature, we are going to explore Empathy. It is a messaging 

program that supports text, voice, video chat, and i le transfers 

over many dif erent protocols. Empathy also lets you add accounts 

from dif erent services and uses them to chat with your contacts. 

Based on Telepathy for protocol support and a UI based on Gossip, 

Empathy is the default chat client in current versions of GNOME, 

(and hence Ubuntu). 

To get started with Empathy simply type ‘Empathy’ in Dash. 

Then click on the Empathy icon to launch the application. When 

you launch it for the i rst time, you’ll be asked to link your online 

accounts. Just link your accounts and you can then easily talk 

to all your contacts. Using Empathy, you can also group all the 

conversations in a single window, have multiple windows for 

dif erent kinds of conversations, easily search through your previous 

conversations, and share your desktop in just two clicks. Now let’s 

learn about Empathy in more detail. 

Learn how to set up and utilise Empathy text 
messenger to the full

“When you launch it for the i rst time, 
you’ll be asked to link your online 
accounts. Just link your accounts and you 
can then easily talk to all your contacts”
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Application settings
When you open Empathy, 
these settings are available 
automatically on the top status 
bar. You can find various settings 
related to conversations, 
contacts and so on here

Other settings
You can see several other 
settings like sounds, calls, 
location, spell check, themes 
and so on as different tabs 
under Empathy>Preferences 

Online accounts
If you select Add Accounts 
in the status bar, you’ll see 
this open up. If you click 
All Settings here, you’ll 
be taken to the System 
settings page

The Empathy interface  Understand how Empathy works and what you can change

General settings
You can find these under 
Empathy>Preferences. Under 
the General settings you can 
set what contacts will be 
visible by default and also 
select the chat settings

Contacts list
This window displays a 
list of all the contacts and 
their current status. To 
chat with anyone from 
this list, right-click on the 
contact, and select chat

Account details
Once you’ve selected an 
already added account 
on the left window, you’ll 
see all the related options 
here. You can choose to 
enable or disable related 
services from here

Accounts list
You’ll see a list of 
accounts added to the 
system here. Click ‘Add 
account’ to add a new 
online account here 

Chat window
This is the actual chat 
window where you 
can converse with your 
contacts. Based on the 
system capabilities, 
you can also chat in 
audio and video mode
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01You can add instant messaging 

accounts from several 

supported services (Fig 1). For some 

account providers, these steps 

will also allow you to register for a 

new account. To add an account, 

click Empathy>Accounts and then 

press +. From the ‘What kind of chat 

account do you have?’ drop-down list, 

select the type of account you wish to 

add. Enter the required information. 

For most accounts, you will only need 

a login ID and a password. Some 

accounts may require additional 

Add a new account

02After you have your accounts 

added to Empathy, the next 

step is to add your contacts and 

manage them. To add contacts, click 

Chat>Add Contact. Then from the 

accounts drop-down list select the 

account you wish to use to connect 

to your contact. Note that your 

contact should be using the same 

service as the account you select. In 

Manage contacts 

First steps with Empathy  Get started with Empathy messenger

information though. Finally click Add 

to confirm the process and save the 

account details.

the Identifier field, enter your contact’s 

login ID, username, screen name, or 

other appropriate identifier for the 

service type. In the Alias field, type 

your contact’s name as you would like 

it to appear in your contact list. Finally, 

click Add to add the person to your list 

of contacts. 

If one or more of your contacts 

has multiple accounts with different 

messaging services, you can combine 

these accounts into a single contact. 

The resulting contact is called a meta-

contact: a contact composed from 

different single contacts. To link 

accounts press the tick button to 

“For most accounts, you will only need a login ID and a 
password. Some accounts may require additional information 
though. Finally click Add to conirm”

Fig 1 Log in to various messaging 
accounts using Empathy
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“Empathy supports 
audio and video 
communication 
using the default 
GUI, but it is still 
dependent on the 
account you use”

03 Empathy supports audio 

and video communication 

using the default GUI, however it is 

still dependent on the account you 

use to communicate. This is because 

only a certain set of services support 

audio and video communication. 

Right now only Google, Jabber 

and SIP accounts are supported. 

Considering you are using one of the 

supported accounts, let’s see how to 

initiate audio and video calls. 

To initiate a call, right-click on 

the contact you want to talk to and 

select Audio Call or Video Call. In the 

next window that opens, you’ll see 

the connection getting established. 

When the connection is established, 

you will see the total conversation 

time at the bottom of the window. 

Once you are done, end the 

conversation by clicking the hand 

up button.

Audio and video 
communication

04To use IRC with Empathy, make 

sure you have at least one 

account added to Empathy already. 

You can then select Rooms>Join 

Rooms, which will open the IRC 

pop-up. You can simply select your 

account name from the drop-down 

and then fill in the room name and 

the server name (Fig 2). You should 

now be able to chat with people in 

the room you joined. Note that an 

IRC network may have many servers 

you can connect to. When you are 

connected to a server on a particular 

network, you can communicate 

IRC with Empathy

select entries you want to link. This will 

enable selection mode and you can 

see a checkbox for each entry. Tick 

the checkboxes that correspond to a 

single person’s contact entries. Finally, 

press Link.

with all users on all other servers 

on that network. You can also add 

and remove servers for this network 

using the Add and Remove buttons. 

When a server is selected, click the 

field under Server or Port to edit it. 

Alternatively, use the left and right 

arrow keys to focus the field, and press 

the space bar to begin editing.

Fig 2 (below) Enter your details 
to enter an IRC chatroom 
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20 LibreOffice 
essentials

As its name indicates, LibreO�  ce is the open-source equivalent 

of Microsoft O�  ce. Complete with programs for word processing, 

creating databases, designing slideshows and more, it is the default 

o�  ce suite for most popular Linux distributions. 

For regular users and novices, it can be di�  cult to comprehend 

just how powerful LibreO�  ce can be. It can be easy to get stuck in 

a rut and not make the most of what it has to of er. For example, 

on a day-to-day basis, you may have no call to use macros, creating 

indexes or doing a mail merge with Writer. But these features can 

vastly improve your productivity and e�  ciency (Fig 1).

Over the next few pages, we are going to highlight some of the 

best ways you can improve your experience – particularly in the 

core Writer and Calc programs. You’ll optimise the way you work 

and start making the most of this feature-full o�  ce software.

Make your working day more productive with 
these indispensable tips for the LibreO�  ce suite

Fig 1 (below) Use the LibreOffice apps 
more productively
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“For regular users 
and novices, it 
can be di�  cult 
to comprehend 
just how powerful 
LibreO�  ce can be”

01Perhaps you are looking to introduce greater readability or to make sure 

your document prints exactly how you want it to. Either way, the way 

forward is in formatting the text. At first it can be a tricky to figure out why certain 

sections of text look how they do, so head to the formatting section to figure it 

out and make changes. On the toolbar is a symbol that looks like a backwards P – 

click that to reveal live formatting symbols, such as rogue paragraph breaks. 

Bring up formatting options 02Creating a list of bullet points 

is fairly easy; click the type 

with dots or numbers and go. You 

can change the formatting of these 

bullet points to be different symbols 

or letters instead of numbers. You can, 

however, also create nested lists by 

using the Tab key to create sub lists, 

and then press Shift+Tab to go back to 

the standard list.

Better bullet points

03Generally in Linux, you can use 

Ctrl+Shift+V to paste text and 

remove its formatting at the same 

time. If you use this in Writer, or find 

Paste Special in the Edit menu, you 

then have several options of how to 

paste the text (Fig 2). One of these 

is unformatted, but it also allows 

for other methods, such as using 

LibreOffice formatting.

Paste unformatted text

Writer

Fig 2 The Paste Special function offers 
options for paste formatting
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04 
Quick 
maths

04Even when 

you’re writing, 

you might need to do 

a quick bit of maths. 

Instead of switching to 

Google or a calculator 

app, you can use 

the formula bar. Go 

to Insert, Object, 

Formula and write 

out the calculation 

you want. Once you 

have confirmed it, 

the outcome of the 

formula appears 

where your cursor  

was placed.

Quick maths

“Even when you’re writing, you might need to do a quick bit of 
maths. Instead of switching to Google or a calculator app, you 
can use the formula bar”

05Pressing F5 or going 

to the View menu 

will allow you to use the 

Navigator function. You can 

use it in large documents 

to quickly move between 

different headings, tables, 

graphics, bookmarks and 

many more objects in the 

document. It’s not a proper 

dock, so you can move it 

around to see what you 

want at any given time.

Quick navigation

06By default, Writer will save new files as ODTs, the open document format. This works in most other word processors, 

but if you’re regularly working with files that need to work on Microsoft Office, you can change the default file format 

to be .doc or .docx. Go to Tools, Options and find the General settings under Load/Save to change the default.

Set default document format
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08Got a 

sentence 

or a word and it’s 

not quit capitalised 

correctly? Pasted 

some text and 

it’s all randomly 

capitalised? You 

can change the 

case of specific 

sections of text 

without re-writing. 

Simply select 

what you want 

to change, right 

click and select 

the Change Case 

option to tweak.

Change case

07Writer has a recovery tool for when unexpected shutdowns happen, but that relies on temporary files and other 

related files that aren’t always there when you really need them. Writer does have a backup system that it can make 

use of though; enable ‘Always create backup copy’ in the Load/Save General options to cover this.

Create a backup system in Writer
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Calc

09 If you’ve created a table, you may need to add a touch of colour in order 

to make it more readable. You can do this manually, however Calc has 

a built-in format option under Format>AutoFormat. From here you can give a 

colour scheme to a table that you’ve selected and even customise what is taken 

into account for formatting.

AutoFormat tables

There are many more 

functions to learn that can 

help you do more with 

LibreOffice and the first step 

is to have a look through 

some of the documentation 

for the software, or just have 

a quick browse through 

all  of the options and the 

available menus.

Learn more!
10Shared spreadsheets 

are good for 

productivity, but the 

more complicated they 

become, the more 

difficult it can be to track 

down an accidental 

change made by one 

of the users. You can 

protect the spreadsheet 

by using Tools>Protect 

Document>Sheet in order 

to give it a password so 

that only certain people 

can make changes.

Protect your
spreadsheet

10 Protect your 
spreadsheet
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11When you select some cells with 

a numerical value inside, you 

get a handy prompt on the status bar 

that tells you the value they add up to. 

That might not be what you want all 

the time, though. Click on that area of 

the status bar to bring up a menu and 

change it to average, maximum or 

minimum numbers in the selection.

Change status bar preview

12Filtering rows helps to organise 

data, but if you’re not sure 

how exactly to go about doing that, 

Calc has an automatic filtering tool 

you can use. Select a row, then go to 

Data>Filter>Auto for it to create an 

automatic filtering system based on 

that row. You can also modify it a bit 

once it’s in place.

AutoFilter rows

“Filtering rows helps to organise data, 
but if you’re not sure how exactly to go 
about doing that, Calc has an automatic 
iltering tool you can use”

13Sometimes you don’t need to see specific chunks of data all the time, and collapsing it like in a piece of code will add 

a bit more space to the viewable page. Using the Outline function under Data>Group and Outline>AutoOutline, you 

can create these collapsible groups, which use a thick outline to indicate themselves.

Grouped cells

14 If you’ve never 

stumbled across 

it, Calc is very smart 

when it comes to 

replicating cells. If you 

write down two or 

three numbers or even 

dates, selecting one 

and dragging the black 

square down to copy 

will automatically fill in 

the cells with numbers 

or dates in the correct 

sequence. If you don’t 

want it to do that, press 

and hold Control when 

copying the cell for 

regular duplication.

Auto-increment 
or copy cells
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15It seems fairly natural for the Enter key to move you down a row of cells and that’s what Calc does by default. However, 

you can actually change the behaviour of the Enter key by going to Tools>Options>LibreOffice Calc, then General to 

have it move along a row instead.

Change Enter key

16 If you have a lot 

of data, rows 

or columns you can 

sometimes find yourself 

browsing the spreadsheet 

not always able to 

remember or divine what 

cell is for what. By selecting 

a row or column you always 

want to be visible, go to 

Window then Freeze to 

keep it always on the top or 

on the left as you browse 

the spreadsheet.

Freeze columns 
in place
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Miscellaneous

17When using Impress for presenting slides, you will often be hooked up to a projector or television that either mirrors 

or acts as an extension to your laptop. Impress has a neat feature where the actual presentation will be shown on the 

big screen, while you can turn on a presenter console just for your laptop display that shows you what’s coming up in your 

presentation, along with notes.

Presenter mode

18 Perhaps you need to paste 

into a document a paragraph 

from another language. The rest of 

the document is in English, so the 

spell check flips out at unfamiliar 

words. Highlight the paragraph, click 

Tools>Languages and then select 

a language for this section of the 

document, and only this section.

Switch between languages 
in spell-check on the fly

19 There is a completely separate 

application for LibreOffice 

called Math that is not, in fact, 

database software, but actually a way 

to draw up mathematical equations 

that can then be inserted into other 

LibreOffice software. This is good if 

you’re writing an academic paper 

with ridiculous maths that needs to 

be readable.

Insert readable formulae

20PDFs can be edited in 

LibreOffice. Simply import 

them using something like Writer 

and it will dump the PDF into the 

Draw application. You can edit text, 

change pictures and even the general 

formatting of the PDF. Once it’s 

done, Draw allows you to export the 

working file as a PDF for everyone 

to use.  

Using PDFs
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Text editing 
with gedit

Text Editor (aka gedit) is the default GUI text editor in the Ubuntu 

OS and the GNOME desktop environment. It is UTF-8 compatible 

and supports most standard text editor functions as well as many 

advanced features like multilingual spell-checking, extensive 

support of syntax highlighting, and a large number of o�  cial and 

third-party plug-ins. With multiple character sets, Text Editor can 

play a versatile role – you can use it to prepare simple notes and 

documents, or create source code using its advanced features just 

like an integrated development environment. gedit is installed 

by default on Ubuntu 16.04 and can be launched via Dash or an 

application shortcut. If you prefer the command line, you can use 

the gedit command to directly interact with the tool.

To open a specii c i le with gedit, type gedit <filename> 

at the command prompt. To open multiple i les, type gedit 

<filename1> <filename2> and so on. You can also open a i le at a 

specii c line number by including +<line number> in the i le path, 

like this: gksudo gedit +21 /etc/apt/sources.list. 

gedit of ers several helpful options, under Edit>Preferences, that 

you may want to review. For example, gedit automatically creates 

a backup copy of i les you edit. If you are running low on space, 

however, you can disable this: just go to Edit>Preferences>Editor tab 

and deselect ‘Create a backup copy’.

Understand its features and learn about its 
many purposes 

“Advanced features include multilingual 
spell-checking, extensive support of 
syntax highlighting, and a large number 
of o�  cial and third-party plug-ins”
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New file
This button lets you create a new 
file in gedit. As you click this, 
new tabs will be created with 
new files. You’ll be asked for a 
location when saving files

Search file
The magnifying glass icon lets 
you search a file, and the next 
icon with a pencil on top lets 
you replace the searched term 
with an alternative one

Save file
After you are done with 
editing the file, click 
this button to save your 
work. If it is a brand new 
file, you’ll also be asked 
to enter the save location

Discover gedit  Understanding the user interface

Undo/redo buttons
You can undo your actions in 
the file or choose to redo them 
using these buttons

Open file
You can open existing 
files from here. Just 
click on the button and 
select the file(s) you 
want to open

Status bar
This bar shows the file 
details, such as encoding, 
current cursor position, 
tab width etc, in real time

Print file
This button lets you print 
the file directly from the 
application. You’ll be 
prompted to add a printer 
if you haven’t already

Edit buttons
You’ll find the edit options 
(Cut, Copy and Paste) 
here. You can also use the 
common keyboard shortcuts 
(Ctrl+X, Ctrl+C and Ctrl+V ) to 
accomplish these actions
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01We’ve already seen how to 

open files in gedit via the 

command line. So let’s understand 

how to manage files in gedit. To open 

a file or set of files in the gedit GUI, 

click the open button or press Ctrl+O. 

In the dialog, select all the files you 

want to open and click Open (Fig 1). By 

default, gedit provides easy access to 

five of your most recently used files. To 

open one, click the downward-facing 

arrow to the right of the open button. 

Once you have selected the desired 

file, it will open up in a brand new 

Handling files with gedit

Uncover key features  Dive deeper into gedit’s capabilities

tab. You can also open files that are 

located on other machines with gedit. 

However, prior to opening a file on 

a server from within gedit, you need 

to know some technical information 

about the server. For example, you’ll 

need the IP address or URL of the 

server, and may need to know what 

kind of server it is (HTTP, FTP etc). Once 

you have all the necessary information, 

go to the Open dialog and click the 

pencil icon to enter the IP address/

URL of the server. Select the file and 

click Open. If you have the required 

privileges, the file should open up 

right away.

“By default, gedit provides easy access to ive of your most 
recently used iles. To open one, click the downward-facing 
arrow to the right of the open button”

02The Find tool can help you 

locate specific sequences 

of text within in your file. To open 

the search window, click Menu>Find, 

or press Ctrl+F. This will move your 

cursor to the start of the search 

window. Type the text you wish to 

search for in the search window. As 

you type, gedit will begin highlighting 

text that matches what you have 

entered. You can scroll through the 

search results using the up/down 

arrow keys or by pressing Ctrl+G. You 

can also highlight a portion of text 

Handling text

Fig 1 Use this dialog box to navigate to text file you want to open
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03If you would like to use 

gedit for text editing, you 

have the option to highlight the 

lines of code you write. gedit uses 

the GtkSourceView for syntax 

highlighting. It uses .lang files to 

define the highlighting schemes. The 

.lang file for a specific programming 

language is located in the /usr/

share/gtksourceview-3.0/language-

specs/ folder. 

You can enable code highlighting 

via the menu by going to 

View>Highlight Mode, or via the lower 

status bar. The status bar, enabled via 

the View menu, displays programming 

language options for many types 

of sources, scripts, markup and 

scientific formats.

Syntax highlighting 

“Locate speciic 
sequences of text 
within in your ile”

with your mouse and press Ctrl+F. 

The text you’ve highlighted will 

automatically appear in the search 

window. For more search options, click 

on the magnifying glass icon in the 

search window. You can select one or 

more of the following search options: 

select Match Case to make the search 

case-sensitive; select Match Entire 

Word Only to search only complete 

words; select Wrap Around to search 

text from top to bottom and cycle 

back again.

04Plug-ins greatly enhance 

the power of gedit and are 

accessed via Edit>Preferences>Plugins 

(Fig 2). More than a dozen plug-ins 

are pre-installed and can be enabled/

disabled here. Extra plug-ins are 

available via the Internet. Here are just 

two of the plug-ins that can help you 

with your day-to-day activities…

Tag List – Displays common tags 

in a side pane and allows for easy 

insertion into the file.

External Tools – This allows the 

user to run external commands on 

the file being edited from within gedit 

itself. Once this plug-in is enabled, 

the user can select custom tools from 

the Tools menu. Note that this is not 

enabled by default.

Plug-ins 

Fig 2 Enable and disable 
plugins using the gedit 
Preferences dialog
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Manage images 
with Shotwell

Most users treat Shotwell as a simple image viewer: a picture is 

double-clicked in Nautilus and pops up in Shotwell. 

But using the product as a simple picture viewer means users 

are losing out on a set of valuable helper features. Shotwell comes 

with a relatively sophisticated database based on SQL technology, 

so that pictures can be stored and retrieved with blazing speed. 

Various advanced options let you tailor the display list to your needs; 

if Shotwell is set up correctly, it will signii cantly reduce the time 

required to i nd specii c images in your (ever-growing) collection of 

i les. What’s more, if your digital camera is set up correctly, Shotwell 

will analyse the EXIF data in order to i nd out the date it was 

captured and other information automatically. Therefore, compiling 

all the photos taken at a single event into one location becomes a 

matter of one click.

The tutorial on the adjacent side of the screen assumes that you 

already passed through the initial coni guration of the product. 

If this is not the case, enter Shotwell into the dash. Click ‘Shotwell 

Photo Manager’ to start the application, and click the OK button 

when confronted with the ‘Welcome to Shotwell’ dialog. Its default 

settings can be accepted without any further ado, but be prepared 

to wait a few minutes as the database gets populated with the 

images and screenshots found in your proi le’s Pictures folder. 

Keep tabs on large numbers of photographs 
with ease using the Shotwell app

“Most users treat Shotwell as a simple 
image viewer. But using it this way 
means users are losing out on a set of 
valuable helper features”
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Last Import view
Click this part of your image 
library to put focus on the latest 
addition. This can be helpful 
if you want to see what items 
were added to the collection 
last – especially handy if you’re a 
‘lazy tagger’

Border indicator
Images can be selected for 
bulk processing. Shotwell 
displays selected pictures with 
a blue frame – using an overlay 
would affect the originality of 
the pictures at hand

Camera list
This part of the main list 
provides an overview of all 
external storage media currently 
connected to your workstation. 
It is a prime destination for 
starting import operations

Organise your shots  Store and retrieve your pictures in no time at all

Events list
Images get catalogued according 
to the date when they were 
taken. Click any of them in order 
to limit the content shown in the 
picture area

Tag list
What the Events list is 
to events, the Tags list is 
to tags: a really helpful 
tool for singling down on 
interesting image material

Zoom lever
The size of the image 
elements in the display 
area can be adjusted to 
your needs. Simply drag 
the lever to the left or 
right in order to find the 
correct balance between 
information density and 
picture quality

Image display
Shotwell displays the 
contents of the currently 
selected section on a grey 
background. Double-click 
any of the pictures in 
order to open them for 
full-screen viewing

SQLite powered
Shotwell stores its data in a 
SQLite database. This leads 
to significant performance 
increases over traditional 
flat file storage – and might 
even permit networking to 
be added one day
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01After coming home from an 

event, start Shotwell and insert 

the memory card of your digital 

camera into an internal or external 

card reader. Shotwell will grasp the 

storage medium automatically, and 

display it as an item in the Cameras 

section of the tree. Wait while 

the progress bar at the bottom is 

populated – the app must read each 

of the images in order to obtain 

further information about it. Next, click 

Import the images

Organise your photos  Handling images with Shotwell

the ‘Import all’ button at the bottom-

right corner of the screen. Shotwell 

will start to copy the images to your 

“After coming home from an event, start 
Shotwell and insert the memory card 
of your digital camera into an internal or 
external card reader”

workstation’s Pictures folder. This 

process can take quite a bit of time if 

the files involved are large. When this 

Fig 1 (above) Images are archived by date
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02When the import process is 

over, your hard drive will lack 

quite a bit of free space. The tree view 

on the left-hand side of the screen 

will show a group of new folders that 

correlate with the dates of when the 

imported pictures were taken.

It’s important that you do not 

touch the sub folders in the Pictures 

directory of your profile. Shotwell 

creates an elaborate folder structure 

that simplifies correlation with the 

database – moving files around can 

have disastrous consequences.

See what happened

03If Shotwell is left to its own 

devices, the pictures will 

be grouped by the day they were 

taken (Fig 1). Since dates, on their 

own, are not particularly informative, 

assigning helpful names is sensible.

Right-click any of the date entries 

and select Rename Event in order 

to make the default name editable. 

Enter a new name and press return 

to commit your changes.

Tags provide a ‘second level’ of 

context, which is overlaid above the 

date information. Tagging images 

is quite easy: select one or more, 

right-click the group and proceed to 

the ‘Add tags’ option in the resulting 

context menu. Shotwell responds 

by displaying a pop-up where one 

or more tag strings can be entered. 

Once tags are added, they show 

up in the tree view automatically. 

Simply click a tag to show all images 

bearing it.

Name events 
and add tags

04Be it fast-moving objects or 

the darkness of the Albaycin 

in Grenada, when the imaging 

situation gets tough, shooting in RAW 

helps you to make the most of your 

images. Sadly, the resulting files are 

not well-suited for sharing because 

most people don’t have the necessary 

viewer on their machine.

Shotwell provides a RAW exporter 

which can be used to transform most 

wide-spread camera files into their 

JPEG equivalents (Fig 2). Get started 

by double-clicking the image in 

order to open it in full-screen mode, 

and right-click it. Next, select ‘Send 

to’. The pop-up window allows you 

to select the format – picking JPG 

ensures that Shotwell generates an 

Share RAW files

“If Shotwell is left to its own devices, the 
pictures will be grouped by the day they 
were taken. Assigning helpful names to 
events is sensible”

05Sending images out one 

by one is a painstaking task 

to complete. Fortunately Shotwell 

can also convert groups of pictures 

in one go. Start out by selecting 

them in Overview mode (Shift/

Ctrl+click) and proceed to selecting 

File>Export. Shotwell will start out 

by displaying the format selection 

dialog from step four, which will be 

followed by a common dialog that 

will permit you to select a storage 

destination from the options. 

Share in Bulk

Fig 2 (above) Files are easily reformatted to 
jpeg  equivalents

process is complete, a message titled 

‘Keep or Delete’ will be displayed. It 

permits you to decide whether the 

images should stay on the memory 

card – picking yes is not an issue, as 

they will not be imported again.

industry-standard picture file. After 

clicking OK, the program displays a 

dialog permitting you to select the 

target. Then images can be sent via 

Bluetooth or email.
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Listen to songs 
with Rhythmbox

High-quality headphones are a great help for dealing with 

background noise – and thanks to multi-core CPUs, playing music in 

the background is simple.

Sadly, obtaining media i les is but part of the challenge; once a 

few thousand MP3 i les populate your storage, music management 

becomes a severe and annoying problem of its own. Ubuntu 

addresses this problem via the Rhythmbox media player. It is a 

combination of a media database, an online radio player and a 

classic, low-resource-consumption media playback utility.

Getting started with Rhythmbox is easy: click a media i le in 

Nautilus, and the player will appear on-screen. Minimise it to proi t 

from background playback – the music keeps on running even if 

you close the application.

Sadly, using Rhythmbox in this fashion means ignoring most of 

the interesting features of the product. Advanced users can create 

custom playlists containing favourite hits – some obscure Falco 

tracks provide a sure-i re way to distract yourself from your work!

In addition to that, the program can also be used as a crossfade 

engine. This means that the annoying gaps between normal MP3 

i les get “bridged over” by superimposing the songs onto one 

another – it might not be able to imitate a DJ’s handywork, but it is 

dei nitely is better than nothing.

Use your workstation to listen to music while 
you work

“Rhythmbox is a combination of a media 
database, an online radio player and a 
classic, low-resource-consumption media 
playback utility”
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Playback controls
If it worked for Apple’s iPod, 
it also works for Rhythmbox. 
These three buttons control 
the playback of the currently 
selected file. This mini-controller 
is handy for changing what’s 
playing quickly

dbus callout
Rhythmbox integrates itself 
into the dbus event system of 
Ubuntu. This means that the 
currently playing track gets 
displayed in an annunciator 
display even if Rhythmbox is 
not actually in the foreground 
at that time

Shuffle and Repeat
No matter how long your playlist 
is, it eventually reaches its end. 
Enabling the loop mode makes 
short work of this problem, as 
Rhythmbox simply starts again 
from the beginning

Play tunes with Ubuntu  Use Rhythmbox to play music unnoticed

Track information
Music takes centre stage in 
RhytmBox. The two labels next 
to the album cover swatch 
provide information about the 
currently playing track, along 
with the album and the artist

Media storage list
The big table below the 
playback controls provides 
you with an overview of the 
media currently scheduled 
for playback. Double-click 
an item to start playing it

Volume toggle
Reducing Rhythmbox’s 
volume independently from 
the rest of the system can 
be helpful. Click the speaker 
symbol and then peruse the 
controls in the flyout to suit 
your preferences

Album cover 
preview
Even though music is an aural 
experience, adding some 
visual spruce is totally worth it. 
Double-click the small icon to 
open a pop-up with a bigger 
version of the image

Seek bar
Ever feel like skipping over 
boring interludes and 
intros? Grab the seek bar 
and drag it to the right. The 
playback position will be 
adjusted automatically
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01This tutorial starts out with 

a scenario to think about: a 

friend provides you with a Gigabyte 

worth of Falco tracks. Let’s assume 

that the USB stick containing the 

files has already been returned 

and the music currently sits in a 

subfolder of a hard disk on your 

machine. Start out by clicking 

File>Add Music. Next, click the 

arrow next to the combobox 

and choose Other to open a file 

selection dialog. Then proceed to 

navigate to the folder containing 

the subfolders with the albums. 

Finally, click Open to close the 

common dialog.

Import the tracks

Manage your tunes  Organise large volumes of media

“When the analysis is done, the list below 
the import controls will populate itself 
with further information”

02Rhythmbox will proceed 

to scan the contents of the 

folder. This process can take up to one 

second per file, which means that 

patience is a virtue here. 

When the analysis is done, the 

list below the import controls 

will populate itself with further 

information about the tracks found. 

Set importing options

Fig 1 Choose where you 
want your music to be 

imported from

Click the Import button to add 

them to the media catalogue of the 

Rhythmbox application. Ticking the 

‘Copy files that are outside the music 

library’ checkbox instructs Rhythmbox 

to copy the media files into the 

Music folder of your profile (Fig 1). 

This is recommended if it resides on 

a removable device that has to be 

returned to its owner, but should be 

left disabled otherwise.



Ubuntu appsListen to songs with Rhythmbox

127

04 Even though Rhythmbox’s 

file list definitely represents 

progress over Nautilus, scrolling across 

thousands of files is not everyone’s 

cup of tea.

The text field below the seek bar 

is intended to accept query strings. 

Entering ‘Fal’ would limit the contents 

of the Artist, Album and Track fields 

Search for tracks

“Double-click a 
song to start the 
playback process”

03Return to the main interface of 

Rhythmbox and click the Music 

tab; the imported tracks will present 

themselves in all their glory. If the 

metadata of the files was not perfect, 

a part of the files will be booked in the 

Unknown category. Most files should, 

however, be catalogued according 

to their artist (Fig 2). Double-click a 

song in the bottom table to start the 

playback process.

View your imports to songs which match Fal in any of 

its metadata fields. Entering a longer 

string reduces the amount of data 

shown – if you know the title of a 

song, simply enter it to show all mixes 

and versions.

Alternatively, right-click an 

interesting song to open up a context 

menu. By default, it will offer you three 

choices: Genre, Artist and Album can 

be used as base for further queries. 

The results will, of course, be shown in 

the file list.

05Favourite tracks should be 

collected in a playlist. Create 

a new one by clicking the little ‘+’ 

symbol at the bottom-left corner of 

the Rhythmbox window. Then, click 

‘New Playlist’ and proceed to enter the 

name of the new playlist. Finally, press 

return and Rhythmbox will commit 

the entered text into its memory.

Create a playlist

06An empty playlist is not worth 

much. Add tracks to its content 

list by dragging and dropping; select 

the file in the Music view, and drag 

it to the playlist. Should your screen 

be too small to display all playlists in 

memory, right-click the desired file. 

The pop-up menu will contain an item 

called ‘Add to playlist’, which comes 

with a handy second list of all playlists 

known to Rhythmbox.

When done, select the playlist in 

the list on the left-hand side of the 

screen. Click any of the tracks in order 

to start playback – now just lean back 

and enjoy the show!

Populate the playlist

Fig 2 All your songs will 
be separated by artist 

and album
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